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Release Notes

Welcome to the September 2014 release of IBM® TRIRIGA® 10.4.1, IBM TRIRIGA Application Platform 3.4.1,
and IBM TRIRIGA CAD Integrator/Publisher 12.1.1. This release includes a full installation of the platform and
applications and a platform-only upgrade installation from 3.0.x or higher to IBM TRIRIGA Application
Platform 3.4.1.

These release notes include the following:

e An overview of enhancements and changes
e Alist of known limitations
e Alist of documentation changes

Many of the descriptions include an internal reference number (Tri-nnnnnn).

Note - To request access to IBM TRIRIGA application upgrade packages or documentation for
releases before IBM TRIRIGA 10.2, submit a ticket through the IBM Software Support site at
www.ibm.com/support.

What’s New in This Release

With IBM TRIRIGA 10.4.1, IBM TRIRIGA Application Platform 3.4.1, and IBM TRIRIGA CAD Integrator/Publisher
12.1.1, IBM TRIRIGA continues to add valuable functionality, fix defects, and reduce the effort necessary for
new and existing customers to implement our products. Highlights in IBM TRIRIGA 10.4.1, IBM TRIRIGA
Application Platform 3.4.1, and IBM TRIRIGA CAD Integrator/Publisher 12.1.1 include the following:

IBM TRIRIGA 10.4.1 Enhancements

The following enhancements to IBM TRIRIGA are in this release:

Area of Impact Description
Mobile Support Includes enhancements for working with IBM TRIRIGA Anywhere Workplace
Operations.

IBM TRIRIGA Application Platform 3.4.1 Enhancements

The following enhancements to the IBM TRIRIGA Application Platform are in this release:

Area of Impact Description

Compatibility with IBM DB2 is now included. The minimum supported version is
IBM DB2 Workgroup Server Edition 10.5.0.4. DB2 is supported on Red Hat
Enterprise Linux, SUSE Linux Enterprise Server, and Windows Server.

Compatibility

Limited use licenses of IBM DB2 Workgroup Edition and IBM WebSphere
Application Server are included for use with IBM TRIRIGA Application Platform.

© Copyright IBM Corporation 2014. 3
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Area of Impact Description
Document Documents and folders in the Document Manager can now be searched. The
Management search does not consider what folder you are starting on; it searches the entire

document tree from the root. (Tri-143113-1V62761)

Mobile Support Enhancements are included for working with IBM TRIRIGA Anywhere Workplace
Operations.

IBM TRIRIGA CAD Integrator/Publisher 12.1.1
Enhancements

The following enhancements to IBM TRIRIGA CAD Integrator/Publisher are included in this release:

Area of Impact Description

Installer TRIRIGA CAD Integrator/Publisher now supports AutoCAD 2015 and AutoCAD
Architecture 2015. (Tri-139800)

Important Installation and Upgrade Information

Before installing, go to the IBM TRIRIGA Application Platform 3 Knowledge Center and read Installing IBM
TRIRIGA Application Platform.

Before upgrading, go to the Upgrading page of the IBM TRIRIGA wiki and read the IBM TRIRIGA Application
Platform 3 Upgrade Installation Guide and the procedures that outline the upgrade steps for a selection of
upgrade scenarios at the following link:
www.ibm.com/developerworks/community/wikis/home?lang=en#/wiki/IBM+TRIRIGA1/page/Upgrading.
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IBM TRIRIGA 10.4.1

This release includes information, known limitations, and changes to IBM TRIRIGA.

Important Information

The following items are important information concerning IBM TRIRIGA for this release:

Area of Impact Description

Geography On the Asset Specification form, in the System tab, the System Geography field
needs to be cleared in order for buildings to be displayed correctly for location,
equipment, and vehicle reservation types in the Room Reservation form for the
Contact Center. (Tri-87474)

Globalization Contact Roles record names can now be translated. If you do not upgrade your
application to 10.4.0, you must republish the following business objects manually
so that the language tables will be created and import of their data will succeed:
<Module name>.<BO name>
System.Help
System.Licence Details
triCiApplicationManager.triCiSpecialField
triSetup.triOfflineContent
triSetup.triUserMessage
(Tri-113883)

Installation If you are upgrading from a previous version of the Application and have not
previously done so, apply the SQL script to update the system fields with sub-
attribute type of CreatedDateTime to CreatedDateTime (Number) and
ModifiedDateTime to ModifiedDateTime (Number). Scripts for Oracle and
Microsoft SQL Server are located on the upgrade disk in the \Scripts folder.
Instructions are within the scripts.

For Oracle, run SetVarcharColsToNumeric_ORCL.sql.

There are two scripts for MSSQL, SetVarcharColsToNumeric_MSSS.sgl and
SetVarcharColsToNumeric_MSSS_Publish_BO.sqgl. Run
SetVarcharColsToNumeric_MSSS.sqgl first. When it completes, run
SetVarcharColsToNumeric_MSSS_Publish_BO.sql.

Notifications An issue was resolved where some internal Notification Detail Helper records
were not being removed after-use, causing the system to become bogged down
with IBS_SPEC and IBS_SPEC_ASSIGNMENT records.

Use the following SQL to identify how many of these records exist in your
environment:

SELECT COUNT(*) FROM

IBS_SPEC

WHERE SPEC_TEMPLATE_ID IN (SELECT SPEC_TEMPLATE_ID FROM
IBS_SPEC_TYPE WHERE UPPER(NAME) =
*TRINOTIFICATIONDETAILHELPER") ;
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Area of Impact Description

The following SQL can be used to clean up the records when the next Cleanup
process is initiated by the system.

UPDATE 1BS_SPEC
SET OBJECT_STATE = NULL,

OBJECT_1D=0-SPEC_ID

WHERE SPEC_TEMPLATE_ID IN (SELECT SPEC_TEMPLATE_ID FROM
IBS_SPEC_TYPE WHERE UPPER(NAME) =
*TRINOTIFICATIONDETAILHELPER™)

(Tri-130778)

Real Estate Abstract The Lease ID of a Lease Abstract record should be unique.

Real Estate Lease Users may experience extended processing times when using the Bulk Create
Review Assumptions Request across a large number of leases. To process more

efficiently, instead of selecting all of the leases at one time for bulk update,
select a few at a time. (Tri-80985)

Space - Plan Moves After you upgrade to 10.4.0 from another version, the Bulk Print Move Items
action on the Move Planner's "All Move Line Items" section displays a blank
screen.

Use the following steps to correct this issue:

1. Log in as an admin user.

2. Go to Tools > Document Manager > TRIRIGA > triltem.

3. Point, but do not click, your mouse at the "Move Request Line Item Record
(BIRT)" document. At the lower left corner of your browser, you may see
"javascript:openDocument(XXXXXX);". The XXXXXX is the document ID.

4. Go to Tools > Builder Tools > Form Builder.

5. Click triPlanning and open triMovePlanner form.

6. Click the "All Move Line Items" query section.

7. In the Properties window, click the "Bulk Print Move Items" action.

8. In the URL of the action property, you will find
"/html/en/default/common/RepBuilder.jsp?source=bulk&docld
=XXXXXX&showFilters=false&queryName=triltem_triMoveRequestLineltem
_triMoveRequestLineltem___MoveDesigner___ BulkPrint___For___ All___ Items".
9. If the document ID is different from the one from step 3, replace the value in
the URL bath in step 8 with the document ID from step 3.

(Tri-128907)

Upgrade When upgrading to 10.4.0, update the patch helper workflow "triPatchHelper -
triCalculate - 10.3.2 - Retro Contract to Set Payment Timing" by changing the
"Update Payment Timing" modify task to have "Map From Records" point to the
"Start" task instead of the "Get Existing Contract" query task. This reduces the
processing time of upgrading. (Tri-128918)

Workplace In the current design for iCal notification attachments, if a room is declined for a

Reservation Manager specific occurrence, an iCal update is not sent. This is working as designed. The
iCal contents are based on the reservation as a whole and are not just for a
specific resource or room. For example, if a reservation is made for two rooms,
the system sends a single iCal attachment - for the reservation. When a resource
or room is declined, the user does receive a notification that indicates the

© Copyright IBM Corporation 2014. 6



Area of Impact

Description

declined status, but the notification does not have an iCal attachment.
(Tri-107380)

When you use the IBM TRIRIGA Reserve tab in Microsoft Outlook to make a
reservation, after you specify the reservation subject, either press Tab or click
outside the Subject field. (Tri-77073)

Known Limitations

The following items are known limitations concerning IBM TRIRIGA for this release:

Area of Impact

Description

Analytics

Gantt

Globalization

Installer for the IBM
TRIRIGA Workplace
Reservation Manager
Add-In to Microsoft
Outlook

Language Packs

Lease Accounting

Real Estate

Environmental
Sustainability

The Create Date of the Asset Event Requests shows the date and time in the
local time zone in the work task record. To find this date and time value, go to
Sustainability > Set Up > Analytics > Rule Engine. From the rule engine, go to the
Tasks tab, and open the task. The Created Date/Time is not in GMT in the
Requests section. (Tri-133787)

If you create many tasks in the Gantt, then delete the tasks from the Gantt, and
then save the project record, some of the tasks may not be deleted. This is
because all of the asynchronous workflows that are triggered by these activities
did not have sufficient time to complete. If this occurs, delete the tasks in the
Gantt that should have been deleted. (Tri-38256)

Attention messages for Classification records display in US English because the
record language for the delivered instance data (system data) is US English.
(Tri-39803)

The installer is only available in US English. Installing to a path under Program
Files may not work in a non-US English-language version of Windows.

Some list values might not display translated values. If you find a list with values
that require translation, use the Language Manager in the Administrator Console
to export the list values for translation, then import them back into the system
by using the Language Manager.

The values in fiscal line items can be incorrect if you issue an index adjustment
calculator before a lease with an index adjustment completes the workflow
processing that occurs upon lease activation. You must wait until all workflow
processing is complete before you issue an index adjustment calculator.
(Tri-115634)

When payments are paid up to the current period and the lease is also amended
in the same period, no catch-up payment is required. However, the first unpaid
fiscal line item on the amended lease is calculated incorrectly. (Tri-115637)

IBM TRIRIGA Real Estate Environmental Sustainability Impact Manager supports a
new ETL Job Item Type for Tivoli Directory Integrator Transformation. In this ETL
job item, the user can add resource files, which will be used during the
execution of this job item. If the job item has a resource file associated with it,
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Area of Impact

Real Estate Lease

Real Estate Lease
Asset Lease

Reservation Survey
Request

Workplace
Reservation Manager

Description

it can be executed successfully by clicking the "Run Process" button. The job
item should also be triggered by the job scheduler according to the defined
schedule, but job scheduler currently can not trigger job items that have a
resource file defined. (Tri-135438)

No list of cost codes is returned by the Service Cost Codes associated to the
Location Cost Code query on the Payment Adjustment form when opened from
the Payment Schedule. Service cost codes can still be manually selected by
switching to the Service Cost Codes query in the Related Reports list.
(Tri-134138)

On the Payments tab of the Owned Property record, the Bypass Date Gap
Validation check box is not displayed. Only the Attention! message displays. The
Bypass Date Gap check box displays in the Accounting Summary section of the
Real Estate Lease record, but the Owned Property record does not display this
section on the Payments tab.

Although the Bypass Date Gap Validation check box is not displayed, the
Attention! message states: "One or more date gaps exist in the payment
schedules. A missing date might result in incorrectly created or missing payment
line items. To proceed, correct the start date and end date of each payment
schedule or select the Bypass Date Gap Validation check box." (Tri-133732)

The date gap bypass Attention! message does not display on an Asset Lease for
date overlaps for semi-annually frequency. You can expect the date gap bypass
Attention! message to display for the first two schedules with the date overlap
although the payment schedule was activated, the payment schedules
scheduled, and the PLIs created. (Tri-133673)

Under the proposed FASB/IASB guidelines for lease accounting (May 2013
Exposure Draft), index leases work only for monthly frequency. Index leases do
not work for non-monthly frequencies, for example, quarterly, semi-annually or
annually. If an adjustment is made from the Index Adjustment calculator, the
adjusted amount is applied to periods that do not have payments, resulting in
incorrect calculations. (Tri-115636)

Weekly, bi-weekly, or 13-period frequencies are not supported for schedule
generation. This is true for current accounting standards and proposed
guidelines. (Tri-115639)

When the Contract Terminate or Contract Expiration pop-up window displays,
you must enter the information correctly before selecting the Continue action. If
any errors are not corrected and the transaction is canceled, the record is still
processed and could remain in an unusable state. The parent or calling record
will transition to the next state regardless of what occurs in the pop-up form.
(Tri-123274)

In a new Reservation Survey Request form, you must select the Create Draft
action before selecting either the Find Parameter Recipients action or the Find
Random Recipients action when the parameter fields are populated. In an
existing Reservation Survey Request form, when the parameter fields are
modified or populated, you must select the Save action before selecting either
the Find Parameter Recipients action or the Find Random Recipients action. If
you do not, neither action works as expected; the action does not pick up the
changes in the parameter fields. (Tri-36865)

When looking at a reservation from Microsoft Outlook Web Access (OWA), the
text on action buttons (such as check in, early notification) does not show clearly

© Copyright IBM Corporation 2014. 8



Area of Impact Description

in preview mode. To see the text more clearly, you can open the appointment.
(Tri-68953)

When you make a one-time reservation for a room that has setup and breakdown
requirements, if the setup and breakdown times overlap another reservation,
currently the booking is accepted when it should be declined. Instead of using
the setup and breakdown feature, reservation coordinators can manually add
separate reservations for the setup and breakdown times. (Tri-115568)

After you have changed the start time of an existing reservation, queries may
still show a record with the old start time in addition to a record with the new
start time. (Tri-134201)

IBM TRIRIGA 10.4.1 Changes

The following changes to IBM TRIRIGA are in this release:

Area of Change Description

Workflow The workflow "triJobRunltem - Synchronous - Run Job Item" is updated so that the
"Update TEMP triETLJobltem" task has "Has Resource File" association. Now, job
schedules can completely invoke and execute a job item with a resource file.
(Tri-136341)

IBM TRIRIGA 10.4.1 Patch Helper Workflows

Patch helper workflows correct the record data in your IBM TRIRIGA application. A patch helper workflow
can revise and update, bring new data records for a release, and recalculate records. The patch helper
makes necessary changes to your IBM TRIRIGA database. You apply the patch helper workflows for a release
after you install or upgrade to that release. Wait for one patch helper workflow to complete before you
begin the next. Some patch helper workflows can take a long time to complete.

The following patch helper workflows are in this release:

Name Description

triPatchHelper - triCalculate - 10.4.1 - This workflow creates an Application Version record for
Application Data - App Version 10.4.1.

triPatchHelper - triCalculate - 10.4.1 - Mobile - = This workflow gives Admin Group, TRIRIGA Service

Create Or Update TRIRIGAAnywhere Folder And = Technician, and TRIRIGA Service Manager Security

Permission Groups permissions to the TRIRIGAAnywhere folder. You
can add more Security Groups by modifying the "Group -
Workflow - Default Groups for TRIRIGAAnywhere Folder"

query.
triPatchHelper - triCalculate - 10.4.1 - Mobile -  This workflow creates barcode intermediate records for
Retro Work Tasks to Create Bar Code each location and asset associated to a work task.
Intermediate Running this workflow is necessary for the barcode

scanning feature on the work list page on the mobile
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Name Description

app to work.

triPatchHelper - triCalculate - 10.4.1 - Mobile - = This workflow updates the out of the box priority and
Update Priority and Status records status records with their respective abbreviations for

use and as displayed in the mobile app.

IBM TRIRIGA 10.4.0 Enhancements

The following enhancements to IBM TRIRIGA are in this release:

Area of Impact

Description

Notifications

Real Estate
Environmental
Sustainability

Real Estate Lease

Sending notification content with different languages has always been based on
the language of the linked record. The administrator now has the ability to send
notification content based on the recipient's language instead. A field in the
Application Settings named Send Notification Based On specifies whether
notifications are sent based on the record's language or the user's language. The
default setting is the record's language. (Tri-124320)

IBM TRIRIGA Real Estate Environmental Sustainability Impact Manager now
provides the option to extend the capabilities of IBM TRIRIGA Real Estate
Environmental Sustainability Manager with the following features to help reduce
energy use and cost:

Analytics added to the current TRIRIGA workflow capability to analyze energy
usage and energy sensor data, such as temperatures and pressures, to identify
assets that are not performing correctly.

Over 40 predefined analytics to improve HVAC and chiller performance, the
equipment that is the major energy consumer for many customers

Automatic creation of corrective work orders to resolve problems that are
identified by the analytics

Automatic creation of corrective work orders from SNMP alerts from other
systems such as a building management system (BMS)

Additional predefined reports on energy usage and sensor data

Tools to allow collected energy use and sensor data to be periodically moved into
TRIRIGA log files for long-term trend analytics

A TRIRIGA Real Estate Environmental Sustainability Impact Manager toolkit is
available on the IBM Integrated Service Management Library. The toolkit assists
customers and service providers to develop integrations that periodically load
energy usage and energy sensor data into TRIRIGA. The data is used by the new
analytics and for reporting. The toolkit is at
http://www.ibm.com/software/ismlibrary?NavCode=1TW10I1B09.

Usability enhancements were made for the adjust payment process.

Tenant improvement calculations for the current FASB standard were added.

© Copyright IBM Corporation 2014. 10
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Area of Impact Description

A processing status indicator to avoid data corruption while workflows are
running an extended process was added.

An alternate use case was added for handling payment line items when a
payment schedule is voided.

A Pro Rata Basis field was added to the Payment Adjustment log form. The field
is always visible. (Tri-127038)

An Actual Adjustment column named triAdjustmentAmountNU was added to the
Index Adjustment Calcs Processing Details and Fair Market Rate Value Calcs
Processing Details related reports on the Payment Processes sub tab of the
Payments tab. (Tri-114869)

A new feature was added to handle mutually exclusive rooms that can be
combined by using movable partitions into multiple variations and sizes.
(Tri-118213)

The process for helping users to schedule rooms for recurring meetings was
enhanced.

Workplace
Reservation Manager

The Reservation Policy feature makes it possible to specify how far in advance a
reservation may be made and to restrict early reservations to a specific set of
users. A typical use of this feature is to allow executive assistants advanced
access to room reservations. When the restricted period ends, reservations are
available to all users. (Tri-115604-1V52419)

You can now specify colors to use in calendars for declined and dependent
resource reservations.

The Reservation system now supports sending TRIRIGA notifications to Outlook
users who do not have a registered user/profile in TRIRIGA. Also, the TRIRIGA
calendar view now displays the Outlook email associated with these reservations
so that reservation coordinators can view the information. (Tri-123790)

You can now limit the number of reservation query results.

TRIRIGA now supports silent installation of the reservation plug-in for Microsoft
Outlook.

The recurring reservation process now supports the ability to resolve conflicts
while making the reservation. (Tri-68952)
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IBM TRIRIGA 10.4.0 Changes

The following changes to IBM TRIRIGA are in this release:

Area of Change Description

Asset Lease

Asset Lease

Asset Lease

Asset Lease

Asset Lease

Asset Lease
Real Estate Abstract
Real Estate Lease

Asset Lease
Real Estate Abstract
Real Estate Lease

Asset Lease
Real Estate Abstract
Real Estate Lease

Asset Lease
Real Estate Lease

Asset Lease
Real Estate Lease

Asset Lease
Real Estate Lease

Asset Lease
Real Estate Lease

Accounting Term Months is now updated on the associated payment line item.
(Tri-125435)

The security group TRIRIGA Contract Manager has been updated to not allow the
page actions to display on the asset lease contract payment schedules. This
change makes an asset lease contract function like the real estate contract with
regard to the payment schedules. (Tri-128661)

The Unit Count column was added to the payment schedule queries on the asset
lease and asset lease template. (Tri-125369)

When applying an asset lease template to an asset lease record, the payment
schedule from the asset lease template correctly applies to the asset lease
record. (Tri-131982)

When the user selects the Voided Payment Schedules related report, then selects
the Recurring Payment Setup related report on the Payments tab, the Unit Count
column displays, not the Contract Rentable. (Tri-125375)

After a lease record is saved, the currency for fields in the IFRS Treatment section
on the Accounting tab are now refreshed with the new currency selected on the
General tab. (Tri-128937)

The name field on the Payment Line Item and the Subject field on simple event
records are marked as localizable. (Tri-129101)

The Payment Instruction Allocation Percentage Attention! Message "percentage”
value is now formatted to four decimal places. The Allocation % field on the
Payment Instruction form rounds to four decimal places, so that the message is
now consistent with the field. (Tri-125617)

Payment line items using partial first payment and partial last payment amounts
now correctly display in the Scheduled Cash Payment field on the Payment Line
Item form. The amount had been incorrectly populated in the Adjustment Amount
field. (Tri-122664)

The ID field is now a read-only field and the link is disabled in the Cash Cost Code,
Expense Cost Code, and Accrual Cost Code sections on the Payment Line Item
form. You can update Cost Codes in the Adjust Payments functionality.
(Tri-124855)

The minimum index adjustment/actual adjustment is now applied correctly to the
FLIs for both current standard and exposure draft. (Tri-115634)

The past due payments on the Summary tab of a lease record now include the tax
value. (Tri-125842)
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Area of Change Description

Asset Lease The revise amendment process no longer copies payment schedules in Void status

Real Estate Lease to the History record. The Void status records now stay with the active record in
Revision In Progress status. Only payment schedules in Scheduled status are
copied over into Pending status.

The Copy process copies all payment schedules in Void, History, Scheduled, and
Pending status into Pending status on the copy record. (Tri-126033)

Asset Lease The TRIRIGA Real Estate Transaction Manager security group no longer allows any
Real Estate Lease form or application actions to display on asset lease and real estate lease
contracts. These forms are read only for this security group. (Tri-128706)

Asset Lease The Void Payment Schedules related report query columns and runtime filters are
Real Estate Lease now in sync with the Recurring Payment Setup related report query on the
Payment Schedules tab. (Tri-125285)

Asset Lease When the Review Assumptions action is submitted, all actions are removed until
Real Estate Lease the calculations are complete to avoid incorrect data calculations. (Tri-115010)
Asset Lease When you extend a lease expiration date, if the Accounting End Date is greater
Real Estate Lease than the Base Lease Expiration Date, the Likely Term End Date (Accounting tab,

Term Assumption section) is now mapped with the new Accounting End Date of
the lease. Otherwise, if the Base Lease Expiration Date is greater than or equal to
the Accounting End Date, the Likely Term End Date is mapped with the new Base
Lease Expiration Date of the lease. (Tri-115638)

Classifications An issue with the correct association on the Federal Building record when
selecting Real Property Use multiple times has been resolved. The association
string will be Classified by Real Property Use.

You can use either of the following methods to correct the existing records:
Method 1: An Admin user can manually remove the association strings.
Method 2: The user can run the specific patch helpers to correct the association;
however, this method is limited to removing the Classified by triRealPropertyUse
association. (Tri-118675-1V54736)

Classifications Natural gas is now classified under Scope 1 (energy type) rather than Scope 2.
The default Base UOM is set to "Energy > Therms" for natural gas and liquefied

petroleum gases. (Tri-114593)

Classifications The Planning Measure Type is now set to blank on all shipping Space Class Current
classification records. (Tri-130092)

Classifications The Record Language on root records for the Weather Stations and Energy Regions
hierarchies has been cleared to enable child classifications to be created in the
correct language for non-US English-language users. (Tri-129588)

Contact Center Equipment and Vehicle reservations now display in the Calendar section of the
Calendar Contact Center form. (Tri-116710)
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Currency The display mask on the UOM_Value record for the Indian Rupees currency is
changed to ##,##,###.00. (Tri-126666)

GIS Location and Geography forms with a GIS tab now use the new EsriJS URL. Each
EsriJS URL maps to a record called GIS Map. Default GIS Map records are delivered
in the application. These default GIS Maps are associated to GIS query records.
(Tri-117995)

GIS Portal sections with GIS maps are updated to use the new EsriJS URL. ArcGIS is no
longer supported. (Tri-122202)

Globalization Changed the Display Mask for Norwegian Krone to ###,###.00 and the UOM
Delimiter to space.
Note: New customers must manually add a space in the Delimiter field for the
"Norwegian Krone" and "Russian Ruble” UOM_Value records. (Tri-130355)

Globalization For non-US English-language users, the subject and content of the Reservation
Satisfaction Survey notification now display in the user's language. (Tri-132625)

Globalization If you are using Arabic or Hebrew, you must set the locale in the Language
Manager of Administrator Console. The correct value for Arabic is ar_EG and the
correct value for Hebrew is iw_IL. (Tri-126658)

Globalization In 15 of the specs forms (triBuildingEquipmentSpec, triConsumablesSpec,
triCoresSpec, triFurnitureSpec, triKeysSpec, triLocksSpec,
triOfficeEquipmentSpec, triServicesSpec, triSoftwarelLicenseSpec,
triSpaceStandardsSpec, triTechnologyAssetsSpec, triTelephoneSpec,
triToolsandTestEquipmentSpec, triVehicleSpec, triworkAreaOutletsSpec), changes
were made to following labels:

General tab - "Specifier" to "Created by" and "Manage Inventory" to "Manage as
Inventory"

Inventory tab -"Quantity Safety Stock" to "Safety Stock Quantity".
(Tri-125180)

Globalization Report axis labels now use translated values. (Tri-128041, Tri-133253)

Globalization The labels in the system BIRT report "Funding Source Summary Report" now are
translated. (Tri-132740)

Globalization The Space Scenario name, which is visible in the Sub Portfolio Plans section of the
Portfolio Plan form, is now translated. (Tri-103655)

Inventory In the Inventory Item form, the "Estimated Stock Value (On Hand)" field is changed
to "Estimated Stock Value On Hand". In the Inventory Count Work Task form, the
"Quantity On Hand (From Record)" label is changed to "Quantity On Hand from
Record" and "Quantity On Hand (From Count)" is changed to "Quantity On Hand
from Count". In the Adjustment Transaction form, the "Quantity to be Posted"
label is changed to "Quantity to Be Posted". (Tri-125175)
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Inventory The following changes were made to inventory labels:

In the Inventory Item form, the label "Estimated Stock Value (On Hand)" is
changed to "Estimated Stock Value On Hand".

In the Inventory Count Work Task form, the label "Quantity On Hand (From
Record)" is changed to "Quantity On Hand from Record" and the label "Quantity On
Hand (From Count)" is changed to "Quantity On Hand from Count".

In the Adjustment Transaction form, the label "Quantity to be Posted" is changed
to "Quantity to Be Posted". (Tri-122756)

Locations The Geocode Address function has been upgraded to work with the Esri Geocode
Service. (Tri-117994)

Locations When creating a space, the correct parent floor is now populated via the
workflow. (Tri-122571-1V58592)

Notifications An issue was resolved where some internal Notification Detail Helper records were
not being removed after use, causing the system to become bogged-down with
IBS_SPEC and IBS_SPEC_ASSIGNMENT records.

You can use the following SQL to identify how many of these records exist in your
environment:

SELECT COUNT(*) FROM

IBS_SPEC

WHERE SPEC_TEMPLATE_ID IN (SELECT SPEC_TEMPLATE_ID FROM IBS_SPEC_TYPE
WHERE UPPER(NAME) = TRINOTIFICATIONDETAILHELPERY);

The following SQL can be used to clean up the records when the next Cleanup
process is initiated by the system.

UPDATE IBS_SPEC

SET OBJECT_STATE = NULL,

OBJECT_ID=0-SPEC_ID

WHERE SPEC_TEMPLATE_ID IN (SELECT SPEC_TEMPLATE_ID FROM IBS_SPEC_TYPE
WHERE UPPER(NAME) = TRINOTIFICATIONDETAILHELPERY)

(Tri-130887)

Notifications Approval escalation duration is now correctly calculated based on the duration
that is defined in the product request template. (Tri-127601)

Offline In Spanish, the label for triBidOffline001 now shows the complete content.
(Tri-132301)

Offline The fields in the Guarantor and Default Remit To sections and the Included In
Rent and LandLord/Third Party fields in the Parking Details section of the RE
Lease Abstract Offline form are no longer protected fields and now allow data
entry. (Tri-131864-1V55013)

Password Reset Password Reset functionality has been added to enable the process to reset a
forgotten password. This process assumes that there is only one email per user
account. (Tri-127771-IV57725)
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Portfolio When retiring a location, more visual emphasis is placed on the Auto Cleanup
fields and an erroneous user message on retired spaces has been corrected. If the
user chooses not to enable the Auto Cleanup functionality, then any assigned
assets, people, and organizations must be manually removed from retired
locations. (Tri-111659-1V52237)

Real Estate Lease An auto-created Space Use Agreement now remains associated to the current
active revision record and the history record when performing a
revise/amendment for the real estate lease or owned property (fee) agreement.
(Tri-127256-1V56919)

Real Estate Lease On a real estate lease, exercising a renewal option now updates the contract
notifications with the new expiration date reminder and sends out the notification
correctly. (Tri-113289-1V52355)

Real Estate Lease On the payment line item form for Real Estate Lease, Owned Property (Fee)
Agreement, and Asset Lease, the actions are hidden when the payment line item
is in active status. The following actions are allowed:

Real Estate Contract section - Find, Clear
Cash Cost Code section - Find, Remove

Expense Cost Code section - Find, Remove
Accrual Cost Code section - Find, Remove

Tax Breakdown section - Add Tax Type, Remove

(Tri-122510)

Real Estate Lease Owned Property (Fee) Agreement is no longer stuck in Processing status if the
record is activated, a payment adjustment performed, then activated again.
(Tri-133591)

Real Estate Lease The Accounting Cost Center on the payment line item (PLI) is now populated from
the value entered on the payment schedule. (Tri-125494)

Real Estate Lease The Bypass Date Gap Validation check box is now hidden when all payment
schedules are removed and the record is saved. (Tri-115144)

Real Estate Lease The contract notification on rolling options is no longer missing. The notification
name now states, “Rolling Option Window Close for (Option Name) option of
(linked contract record name). This Option must be exercised by (Effective To
Date). (Role) to review.”

If you upgrade to 10.4.0, you must run patch helper Application Setup Data.
(Tri-113947-1v51849)
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Real Estate Lease The Cost per Unit field on the payment schedule is now read-only. The Cost per
Unit amount is calculated on Create or Save actions.

For RE Lease / Owned Property / Lease Abstract, the calculation is based on
Annual Amount / Contract Rentable

For Asset Lease, the calculation is based on Annual Amount /7 Unit Count.
(Tri-94266)

Real Estate Lease The Create Schedule(s) action generates an Attention! message and displays the
Bypass Date Gap Validation check box when the payment schedules have the same
End Date on the Generate Payment Schedule form. This is now consistent with the
Attention! message on the lease Activate action. (Tri-115145)

Real Estate Lease The Create Schedule(s) action on the Generate Payment Schedule form now
correctly generates an Attention! message when any of the required From Date,
To Date, or First Payment Date fields are blank. First Payment only applies to
payment schedules using the Other frequency type. (Tri-115149)

Real Estate Lease The field size for the Name field on the Payment Schedule and Payment Line Item
business objects was increased to 700 to correct a mismatch. (Tri-130177)

Real Estate Lease The Is Notice Required Before Non-Monetary Grace Period Begins field and the
Grade Period for Non-Monetary Default field in the Default Clause section under
the Default tab of the Lease Abstract form now display correctly in the columns.
(Tri-131275)

Real Estate Lease The real estate lease option dates are no longer recalculated when the Option
form is canceled with the form "X". (Tri-129934-1V59287)

Real Estate Lease The retrieval of the Payment Schedule and PLIs has been changed to be 'More
Than or Equals' which allows the Termination Effective Date to be equal to or
after the date of the first Payment Schedule and PLIs.

The label on the Contract Terminate form was changed to "Void payments on and
after termination date".

The label on the Contract Expiration form was changed to "Void payments on and
after expiration date". (Tri-122953)

Real Estate Lease The TRIRIGA Lease Accountant security group was updated. Now the Generate
Payment Schedules section action displays on the Real Estate Lease contract
Payments tab. This change makes the Generate Payment Schedules section action
for a Real Estate Lease contract function the same as it does for an Asset Lease
contract. (Tri-128704)

Real Estate Lease When applying a real estate lease template to a real estate lease record, the
payment schedule from the real estate lease template is correctly applied to the
real estate lease record. (Tri-132070)

Real Estate Lease When doing a payment adjustment, if there is a partial first and partial last
amount for the same month, the system now combines the amount and represents
it as one PLI. (Tri-126827)
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Real Estate Lease When terminating a real estate lease after an amendment, the straight-line value
of Rent Expense column in the Schedule Straight Line section is now correct.
(Tri-115637)

Real Estate Lease A lease with a Location Specific Quarter schedule now correctly moves out of
Asset Lease Processing status. (Tri-124365)

Real Estate Lease Accounts receivable deposit payment schedules that are auto-generated through
Asset Lease the lease clause setup now correctly change from Processing to Scheduled status

when the lease is activated. (Tri-131376)

Real Estate Lease Corrected an issue where the Tenant Improvement Incentive was deducted from
Asset Lease the Minimum Lease Payments (MLP), for example the rent, for Current Accounting
Standards. (Tri-115633)

Real Estate Lease The residual value guarantee is now reflected for the schedule type A/type B from

Asset Lease the history lease when a lease is extended through the amendment process. The
residual value was being reflected only for the last period and not for the original
period before extension. (Tri-115635)

Real Estate Lease The security group TRIRIGA Contract Manager has been updated to not allow any
Asset Lease form or application actions to display on the asset lease and real estate lease
contracts. These forms are read only for this security group. (Tri-128681)

Real Estate Lease The following fields in a real estate lease can be translated:

Globalization - triRealEstateContract business object - triFasbCapitalorOpLeaseTX field
- triAssetLease business object - triFasbCapitalorOpLeaseTX and
triFasbLeaseTreatmentTX fields

(Tri-109350)

Real Estate Payment schedules from an RE Project Lease are now created when creating
Transactions schedules using the Generate payment schedules form. Issues related to the
Create and Create Cash flows schedules action are also corrected. (Tri-130378)

Real Estate The BO Mapping for the triReceivingLineltemLog business object in the
Transactions trilnventoryTransaction module now uses the Topic field instead of the Name
field. (Tri-107588)

Real Estate The Financial Analysis tab and Summary Metrics tab were removed from the
Transactions following RE Transaction Term forms:

- RE Transaction Acquisition Terms
- RE Transaction Current Terms

- RE Transaction Sublease Terms

- RE Transaction Lease Terms

- RE Transaction Termination Terms
- RE Transaction Disposition Terms
- RE Transaction Expiration Terms

(Tri-131531)

© Copyright IBM Corporation 2014. 18



Area of Change Description

Real Estate The section actions on the Financial Terms tab of all RE Project forms are now
Transactions visible for a user logged in as TRIRIGA RE Transaction Manager. (Tri-101734)
Reporting A formula indication has been added to the column heading of "Variance" in the

following System Report, another column is added to the report to display
variance in $. In addition, the variance is renamed to "Budget Variance".

Title: Project Cost Summary - All Projects
Name: triCapitalProject - BIRT - Project Cost Summary AllProjects

(Tri-128845)

Reporting A layout issue was corrected for the following reports:

Active Transaction Plans (BIRT)

Asset Invoice Summary Bulk Print (BIRT)
RE Invoice Summary Bulk Print (BIRT)
Contract Summary (BIRT)

Daily Reservations Report (BIRT)
Condition Assessment - Funding Analysis Summary Record (BIRT)
LEED Checklist3 (BIRT)

Space Rollup Summary Building (BIRT)
Space Rollup Summary Floor (BIRT)
Space Rollup Summary Property (BIRT)
Vendor Performance (BIRT)

Vendor Performance Portal (BIRT)
Weekly Reservations Report (BIRT)

(Tri-129734)

Reporting Corrected an issue where the last day of the reporting period was not captured by
the date-range based ETL job items. (Tri-84732)

Reporting Sections of the Move Planner which contain the 'Bulk Print Move Items' action
might not point to the correct report. To manually point to the correct BIRT
report, you must complete the following steps after you upgrade to version
10.4.0:

1. Log in as an admin user.

2. Go to Tools > Document Manager > TRIRIGA > triltem.

3. Point, but do not click, your mouse at the "Move Request Line Item Form
Report (BIRT)" document. At the lower left corner of your browser, you may see
"javascript:openDocument(XXXXXX);". The XXXXXX is the document ID. Make note
of this ID.

4. Go to Tools > Builder Tools > Form Builder.

5. Click triPlanning and open triMovePlanner form.

6. Click the "Move Line Items for Selected Request" query section.

7. In the Properties window, click the "Bulk Print Move Items" action.
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8. In the URL of the action property, you will find
"/html/en/default/common/RepBuilder.jsp?source=bulk&docld
=XXXXXX&showFilters=false&queryName=triltem_triMoveRequestLineltem
_triMoveRequestLineltem___MoveDesigner___ BulkPrint___For___ Request".

9. If the document ID is different from step 3, replace the value in the URL path
in step 8 with the document ID from step 3.

10. Click the "Move Line Items for Selected Project" query section.

11. In the Properties window, click the "Bulk Print Move Items" action.
12. In the URL of the action property, you will find
"/html/en/default/common/RepBuilder.jsp?source=bulk&docld
=XXXXXX&showFilters=false&queryName=triltem_triMoveRequestLineltem

_triMoveRequestLineltem___MoveDesigner___ BulkPrint___For___ Project".

13. If the document ID is different from step 3, replace the value in the URL path
in step 12 with the document ID from step 3.

14. Click the "Move Line Items for Selected Scenario” query section.

15. In the Properties window, click the "Bulk Print Move Items" action.
16. In the URL of the action property, you will find
"/html/en/default/common/RepBuilder.jsp?source=bulk&docld
=XXXXXX&showFilters=false&queryName=triltem_triMoveRequestLineltem

_triMoveRequestLineltem___MoveDesigner___ BulkPrint___For___Scenario".

17. If the document ID is different from step 3, replace the value in the URL path
in step 16 with the document ID from step 3.

(Tri-131360)

Reporting The BIRT report for Bulk Print Move Line Items is converted from form report to a
query report. (Tri-129202)

Reporting The following queries were removed:

triEnvCarbonLog - REPORT - Grainger Emissions Report
triEnvCarbonLog - REPORT - Grainger Environment Impact Report

These two queries can be manually removed if not used anywhere in the system.
(Tri-113187)

Reporting The system BIRT report named triCapitalProject - BIRT - Project Cost Summary -
Portal now displays the data correctly in languages other than US English.
(Tri-131289)

Reporting The variance in the "Project Cost Summary - All Projects" BIRT report now shows
the same display format as the format used in the Budget Variance (%) field in the
Summary section in the Budget tab of Capital Project records. (Tri-128740)
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Requests

Requests

Requests

Specifications

System Setup

System Setup

Workplace
Operations

Workplace
Reservation Manager

Workplace
Reservation Manager

Workplace
Reservation Manager

Workplace
Reservation Manager

Workplace
Reservation Manager

Workplace
Reservation Manager

Workplace
Reservation Manager

Workplace
Reservation Manager

Workplace
Reservation Manager

Inventory items from the On Hold transaction form now work correctly for
consumable and assignable items. (Tri-127974-1V58938)

Move Services for small move/group move now shows the correct spaces for the
To Location based on the functional role of the person being moved. (Tri-126987-
IV56863)

Resources are now copied from the task template if a work task is created from a
request or a planned maintenance schedule. (Tri-124701)

Labels in the specification forms were changed to improve clarity. (Tri-122761)

A list value for Design Change Request has been added to triLinkedForm list. The
linked form value on the Contact Role Setup record for RE Project Sublease is
reselected to display the correct value from the list. (Tri-129468)

The default value for a Planning Measure Type list in a new Space Class Current
Classification record is changed to Occupancy. (Tri-129376)

The Procedure Step was removed from the Add list of Safety Plans (Procedures) in
the Floor record in an object migration environment. (Tri-114836)

An update iCAL attachment for each exception is now sent with the notification
after a reservation is submitted. (Tri-128554)

Corrected typographical errors in the Workflow Builder field labels ‘Original
Commencement Date' and '‘Commitment Original for the original Commitment'.
(Tri-121823)

Resolved an issue that caused series reservations to not be declined when the
reservation occurred outside the room's calendar. For example, a series
occurrence showed as accepted on a weekend for a room having a Monday-Friday
calendar. (Tri-118868)

Resolved an issue where Reservations could only be opened by the delegate who
created the reservation. (Tri-124208-1V56284)

Resolved an issue where Vehicle and Equipment inventory items that were
removed from a Primary Location were still displayed in the Location Reservation
form as available to be reserved. (Tri-122028)

Spaces that have the check box for "Do Not Allow Series Reservations" selected as
part of a Reservation Space Group no longer show in the queries when the
reservation is a recurring reservation. (Tri-124324)

The Account Detail action is now available as appropriate for the state of the
record. (Tri-113286)

The detail information in the email notification that is sent from non-US English-
language user now contains all information. (Tri-129936)

The triCancellationChargesNU formula field is no longer recursive. This resolves an
issue when running a year service window. (Tri-129094-1V59103)
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Workplace
Reservation Manager

Workplace
Reservation Manager

Workplace
Reservation Manager

Workplace
Reservation Manager

Workplace
Reservation Manager

Workplace
Reservation Manager

Workplace
Reservation Manager

The update/exception iCAL now updates the correct date and time. (Tri-130482)

Users that are not the Reservation Coordinator to any space record can no longer
see private rooms. (Tri-120116-1V54302)

When a recurring reservation with no end date or in which the end date is beyond
the cut-off date time (reservation start date time + cut-off duration), the
reservation is declined. The user must change the end date and re-book the room.
(Tri-68981)

When a reservation is changed, the food orders and equipment orders are now
retired correctly. (Tri-126245)

When creating a reservation, the logged in user must have time zone set. If the
user's time zone is not set in the user’s profile, a user message displays and the
reservation is in read-only mode. (Tri-69376)

When deleting a reservation space group with a space associated to it (using
"Delete” in Location hierarchy), the Do Not Allow Series Reservations field on the
associated spaces is now unchecked. (Tri-126159)

When the Reserve Cut-Off Duration = 0 on a space, a user can now create a no
end recurring reservation. The space shows up in the available spaces for the user
to select. (Tri-125277)
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IBM TRIRIGA 10.4.0 Patch Helper Workflows

Patch helper workflows correct the record data in your IBM TRIRIGA application. A patch helper workflow
can revise and update, bring new data records for a release, and recalculate records. The patch helper
makes necessary changes to your IBM TRIRIGA database. You apply the patch helper workflows for a release
after you install or upgrade to that release. Wait for one patch helper workflow to complete before you
begin the next. Some patch helper workflows can take a long time to complete.

The following patch helper workflows are in this release:

Name Description

triPatchHelper - triCalculate - 10.4 -
Application Setup Data

triPatchHelper - triCalculate - 10.4 -
Application Data - App Version

triPatchHelper - triCalculate - 10.4 - Energy
Optimization - Reset Rule Definition Form
Meta-Data

triPatchHelper - triCalculate - 10.4 - Energy
Optimization - Retro Main Meter & Utility Rate
Plans Section on Utility Meter Assets

triPatchHelper - triCalculate - 10.4 - Energy
Optimization - Retro DEFAULT Asset Analytic
Process

triPatchHelper - triCalculate - 10.4 - Energy
Optimization - Retro Utility Rates Tab on
External Company

triPatchHelper - triCalculate - 10.4 - Energy
Optimization - Fix Rule Parameter Published
Name

triPatchHelper - triCalculate - 10.4 -
Application Settings Defaults

triPatchHelper - triCalculate - 10.4 - Energy
Optimization - Retro DEFAULT Asset Job
Schedulers

triPatchHelper - triCalculate - 10.4 - Energy
Optimization - Retro Resource File Section on
ETL Job Items

triPatchHelper - triCalculate - 10.4 - Bidi -
Retro DEFAULT Base Text Direction

© Copyright IBM Corporation 2014.

This workflow adds classifications, user messages,
notifications, and the like for 10.4.

This workflow creates an Application Version record for
10.4

This workflow updates Rule Definition Form meta-data
based on Event Type. This workflow is created for
INTERNAL USE only.

This workflow updates assets having a Spec Class of
"Utility Meter" to display the new "Main Meter?" field on
the General tab and the new "Utility Rate Plans" section
on the Environmental tab.

This workflow updates "DEFAULT" Analytic Process with
their appropriate Rule Definitions & Rule Parameters
associations

This workflow updates "external company" organization
records having an organization type of "Utility Supplier”
to display the new Utility Rates tab.

This workflow updates All Rule Parameters with new
Published Name to include Control Number. This
workflow is created for INTERNAL USE only.

This workflow sets the default values on "Application
Settings" record

This workflow updates DEFAULT Asset Job Schedulers to
show associated ETL Job Item

This workflow updates existing ETL Job Items that are
ETL Transformations to display the new Resource File
Query Section

This workflow sets the default value of the Direction of
user-generated text field to Default in the Employee
records
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Name Description

triPatchHelper - triCalculate - 10.4 - Update This workflow is to update the Name on CAM
UOM_Value Records classification record and Name on CAM Type Cash Flow
Line Item records to "Common Area Maintenance"

triPatchHelper - triCalculate - 10.4 - Reserve - This workflow removes existing association from space
Remove Specs From Spaces to specification if association between the primary
location of the space and specification does not exist.

triPatchHelper - triCalculate - 10.4 - Retro This workflow corrects all Federal Building records with
Federal Building with Real Property Use incorrect association selected for Real Property Use.
triPatchHelper - triCalculate - 10.4 - Retro This workflow corrects all Federal Land records with
Federal Land with Real Property Use incorrect association selected for Real Property Use.
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IBM TRIRIGA Application Platform 3.4.1

This release includes important information, known limitations, changes, and property file changes to the
IBM TRIRIGA Application Platform.

Important Information

The following items are important information concerning the IBM TRIRIGA Application Platform for this
release:

Area of Impact Description

Accessibility Some of the links in a calendar, such as today, previous month, choose month,
and next month, are not accessible. If the screen reader does not announce the
month and year, type the date directly in the text field. (Tri-92422)

The scroll left and scroll right buttons in a row of tabs are not accessible by using
the Tab key. The user can access those buttons by using the mouse to scroll to
them. The drop-down menu can be accessed by using the keyboard and pressing
Ctrl+down arrow key. (Tri-92435)

If the autocomplete feature is enabled for a locator field, users must specify the
exact string in the input field so that a unique record can be automatically
assigned after the user moves out of the input field.

If a search returns multiple records, the user must move out of the input field
and use the selector icon to select the record.

If there is no matching record to a specified string, users cannot use the Tab key
to move out of the input field. If the screen reader keeps saying the Tab key,
users must press the Esc key to tab to the next element. (Tri-96117, Tri-92431)

The Attention section is not accessible. If an application message is displayed,
the message is not read by the screen reader. However, the application messages
are accessible through section navigation and landmark navigation.

For example, if a visually impaired user is typing a value in the Password field
that does not follow the company's password rules, the attention section displays
a warning, but the screen reader does not read it. So, the user does not receive
the warning that the entered value is not valid. (Tri-100541, Tri-92816)

In Internet Explorer, if a portal page display extends beyond the bottom of the
window, and a user presses Ctrl+space to open a portal section button, the
portal page display scrolls to the bottom of the window.

The portal section button retains the focus. (Tri-92252)

The focus box and the dashed lines are not visible in the portal for quick links of
the type Large View.

Workaround: The status bar at the bottom of the browser shows the target URL
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of the currently focused quick link. The name property in the URL is the label of
the quick link, for example, name=Builder+-+Portal+Builder. (Tri-103893, Tri-
109460)

The focus box or dashed line is not visible when the current focus is on the
column header of a hierarchical report.

Look at the status bar where the column header label is displayed. (Tri-109452,
Tri-107966)

Browsers Browser Important Information

Apple Safari The following builder tools are not supported:
Classifications, Lists, Data Modeler, Form Builder,
Association Manager, Workflow Builder, Portal Builder,
Navigation Builder, State Family Manager, Scorecard
Manager, License Manager, Security Manager, Data
Integrator, Object Migration, Currency Conversions, Label
Manager, and Style Manager.

Excel sections are not supported.

Safari does not support dragging and dropping files from
the finder into the multi-file uploader in the Document
Manager. (Tri-80867)

There is limited support for HTML5 charts.

Google Chrome The following builder tools are not supported:
Classifications, Lists, Data Modeler, Form Builder,
Association Manager, Workflow Builder, Portal Builder,
Navigation Builder, State Family Manager, Scorecard
Manager, License Manager, Security Manager, Data
Integrator, Object Migration, Currency Conversions, Label
Manager, and Style Manager.

Excel sections are not supported.
Java applets are not supported for Chrome on Mac OS X.
There is limited support for HTML5 charts.

For BIRT printing to PDF, use the Chrome PDF viewer
instead of the Adobe PDF plugin. For more information,
use your browser to search for How To Enable the Built-in
PDF Viewer in Google Chrome. (Tri-67281)

If your locator field drop-downs and navigation menu
drop-downs are hidden behind applets like stacking,
availability, and Gantt sections, minimize the applet
section and reopen it when you need it again. (Tri-66901,
Tri-71492)

Internet Explorer  Due to a known limitation in IE 10, the background color
on fields may show when the record is printed from the
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print preview page. (Tri-75848)

The following builder tools are not supported in IE 10 or
IE 11:

Classifications, Lists, Data Modeler, Form Builder,
Association Manager, Workflow Builder, Portal Builder,
Navigation Builder, State Family Manager, Scorecard
Manager, License Manager, Security Manager, Data
Integrator, Object Migration, Currency Conversions, Label
Manager, and Style Manager are not supported.

In IE 10 and IE 11, Excel sections are not supported.

Query sections do not display correctly if the browser
zoom is set to a custom value that is less than 100%. The
default browser zoom is 100%. (Tri-33883)

Some builder tools do not load or work correctly if the
browser zoom is set to a custom value that is less than
100%. The default browser zoom is 100%. (Tri-28866)

When a user exports a PDF file from a graphics section, IE
may display a security message in the browser window.
To prevent this security message from displaying, add the
IBM TRIRIGA application URL to IE’s Internet Security list
of Trusted Sites zone. In the Security Settings for Trusted
Sites Zone, set the Download permission to not display
the warning message. (Tri-31024)

Mozilla Firefox The following builder tools are not supported:
Classifications, Lists, Data Modeler, Form Builder,
Association Manager, Workflow Builder, Portal Builder,
Navigation Builder, State Family Manager, Scorecard
Manager, License Manager, Security Manager, Data
Integrator, Object Migration, Currency Conversions, Label
Manager, and Style Manager.

Excel sections are not supported.

Fixed-column queries do not remain fixed in place due to
a Firefox limitation.

Opening a new record in the popup view opens the new
window behind the window that originated it. This is a
known issue with Firefox / Adobe Flash. Disabling the
plug-in corrects the issue. You can find more information
in the following article: http://support.mozilla.org/en-
US/questions/938033 (Tri-78853)

There is limited support for HTML5 charts.

Firefox may not close all windows automatically when
signing out of a single sign-on session. (Tri-84899)

Firefox has a feature that blocks ALL Java plug-ins. Users
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see the following message: "Activate Java Deployment
Toolkit. This plug-in has security violations." For more
information on how to activate the plug-in for use with
TRIRIGA applications, see
https://support.mozilla.org/en-US/kb/how-allow-java-
trusted-sites. (Tri-130970)

Business Objects If you upgrade the platform to 3.4 but do not also upgrade the application to
10.4, many business objects must be republished to support localization changes.

Option 1: To republish all of the business objects, you can follow the instructions
given in the Publish_all_BOs_For_localization_MSSS.sql or
Publish_all_BOs_For_localization_ORCL.sql scripts, which are found
in the scripts directory of the Application Upgrade disk.

Option 2: You may choose to manually republish the business objects. The
following business objects, listed with business object name first and module
name in parentheses, need to be republished:

Classification (Classification)

Cost Code Container (triCostCode)

Data Utilities (Data Utilities)

Document Container (Document)
Geography (Geography)

Group (Group)

Group Member (Group)

Holidays (System)

Location (Location)

Organization (Organization)

Permission Line Item (triPeople)
Polylining Standard (Polylining Standard)
Project Group Container (Group)

ROOT (Document)

triAnalyticEvent (triAnalyticEvent)
triAnalyticltem (triAnalyticltem)
triAnalyticProcess (triAnalyticProcess)
triAnalyticRule (triAnalyticRule)
triApplicationSettings (triSetup)
triApproval (triRouting)

triApprovalRule (triSetup)

triAssetEvent (triAnalyticEvent)
triAssetLink (triAsset)

triBidResponse (triProposal)
triBuildingSystem (triBuildingSystem)
triBuildingSystemLink (triBuildingSystem)
triCatalog (triCatalog)

triCatalogLink (triCatalog)
triCiApplicationDefinition (triCiApplicationManager)
triCiAssociatedObject (triCiApplicationManager)
triCiHierarchyNode (triCiHierarchyNode)
triContactRole (trilntermediate)
triContract (triContract)

triContractLink (triContract)
triCostCode (triCostCode)
triCostltemLink (triCostltem)
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triCTQAssessment (trilntermediate)
triDataAttributeltemintermediate (trilntermediate)
triDesignLink (triDesign)
triEnergyRatingErrorLog (triLog)
triEnergyStarValidationltem (trilntermediate)
triExternalMailServer (System)
triGeographyLink (Geography)
trilnspectionLink (trilnspection)
trilnventoryLocation (trilnventorylLocation)
trilnventoryLocationLink (trilnventoryLocation)
triltemLink (triltem)

triKeySecurity (trikeySecurity)
triLeaseAbstract (triContract)
triLeaseAbstractAction (triActionForm)
triLocationEnergySpace (trilntermediate)
triLocationLink (Location)
triNotificationDetails (triRouting)
triOSCREUtil (Data Utilities)

triPeopleLink (triPeople)

triPermitLink (triPermit)

triPlan (triPlanning)

triPlannedSpace (Location)

triPlanning (triPlanning)
triPlanningConflictltem (triPlanningltem)
triPlanningEnvironment (triPlanning)
triPlanningPerioditem (triPlanningltem)
triPlanningScopeltem (triPlanningltem)
triProductsAndServicesLink (triProductsAndServices)
triProjectCalcltem (triCalculationltem)
triProjectLink (triProject)

triProjectReport (triProgressReport)
triProjectUpdater (triActionForm)
triREContractLocations (trilntermediate)
triRequest (triRequest)

triRequestLink (triRequest)
triReservationGroup (triSetup)

triResource (trilntermediate)
triRetailCompany (trilntermediate)
triReview (triActionForm)

triReviewer (trilntermediate)
triScheduleTask (triTask)
triSpaceForecastitem (triPlanningltem)
triSpaceForecastSurvey (triPlanning)
triSpacePlan (triPlanning)

triSpaceScenario (triPlanning)
triSpecificationLink (triSpecification)
triSurveyQuestionResponse (trilntermediate)
triTaskLink (triTask)
triTaskResourceAllocation (triTaskAllocation)
Working Hours (System)

(Tri-128841, Tri-128369)
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Graphics Exporting very large graphics could require configuring your web server with a
larger maximum post size. (Tri-28770)

Exporting from a graphics section does not work properly on WebSphere with
SSL. By default, WebSphere adds additional caching headers to responses that
already contain cache control, which causes issues in IE when trying to stream
application data like PDF files back to the client. This can be disabled via a
custom property for your application server in the WebSphere Integrated
Solutions Console. Note that this change merely prevents WebSphere from
automatically adding headers; you are then left with the cache control headers
that IBM TRIRIGA intends to be there. Please reference the following guide:
http://publib.boulder.ibm.com/infocenter/wasinfo/v6rl/index.jsp?topic=%2Fco
m.ibm.websphere.express.doch2Finfo%2Fexp%2Fae%2Frrun chain httpcustom.ht
ml

Following the steps in that guide, add a custom property named
CookiesConfigureNoCache with a value of False to your secure HTTP
transport channels.

After completion, restart the server, and the Export works properly. (Tri-34664)

Installation IBM TRIRIGA does not currently support container databases in Oracle 12c. When
Installing and configuring your Oracle 12c database with 'dbca’, do not choose the
"Create As Container Database" option. (Tri-105909)

It is no longer possible to upgrade from IBM TRIRIGA Application Platform version
2.7.x or earlier. To upgrade from 2.7.x or earlier, you must first upgrade to
version 3.3.1.0, and then upgrade to this platform version. (Tri-95335)

Microsoft Excel The Office Web Components (OWC) library that IBM TRIRIGA uses for Excel
sections is not available in a clean install of Office 2007 or Office 2010. For
information about downloading the OWC library and installing it as a separate
component, search for office web components roadmap on the Microsoft website
http://blogs.office.com. You do not need to download and install the OWC
library if you upgrade Office 2000 or Office 2003 to Office 2007 or Office 2010,
because the OWC library is available.

Microsoft SQL Server If the upgrade of an MSSQL database with MBCS enabled fails and you see in the
ant. log that there were invalid views during the NVarchar Conversion process,
use the following recovery steps:

Review the ant. log to identify the invalid views.
Run the upgrade with MBCS Support turned off.

Log into IBM TRIRIGA and republish the business objects identified in the
ant. log as having invalid views.

Run upgrade with MBCS Support turned on. (Tri-32284)
If you are upgrading an MSSQL database with MBCS enabled, before the upgrade
to 3.4.x, you must (1) back up your database, and (2) republish the

triRealEstateContract business object in the triContract module, the
triBuilding business object in the Location module, the
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trilLeaseAbstract business object in the triContract module, and the
triREProject business object in the triProject module. This is to avoid a
possible MSSQL error on the backing table of one of these business objects during
the upgrade. The error that might occur if a business object is not republished is
as follows: "Cannot create a row of size xxxx which is greater than the allowable
maximum row size of 8060". If this error occurs, a table is not configured
correctly for MBCS. In this case, restore the database. If you republished those
four objects before upgrade, contact the IBM TRIRIGA team at IBM Software
Support for instructions. If you did not, republish those objects and try the
upgrade again. (Tri-31926, Tri-94270)

If you have custom tables in the IBM TRIRIGA table space and you are upgrading
to MBCS on Microsoft SQL Server, these tables may not convert correctly
depending on the table definition (for example, if IDENTITY_INSERT is set).
These tables need to be either deleted or converted manually before running the
3.4.x MBCS upgrade.

To convert these tables manually, alter all varchar fields to be nvarchar and
alter their collation to the collation used during the conversion during install. For
example, for field XXX in table YYY when your desired collation is
Japanese_CS_AS and the SIZE of the varchar field is 100, the script is as
follows: alter table YYY alter column XXX nvarchar(100) collate
Japanese_CS_AS (Tri-32702)

Microsoft SQL Server has a row size limit of 8060 bytes. On MSS2008, there is an
overflow mechanism that transparently enables a row to logically exceed 8060
bytes while physically overflowing some of the extra data into a separate part of
the database. More information about the 8060 byte limit can be found at the
following link: http://msdn2.microsoft.com/en-us/library/ms186981.aspx.

Navigation Pressing a key or key chord and the Access Key character navigates the user
directly to the tab or triggers the action defined in the Form Builder. Different
browsers use different keys or key chords, as follows:

For Microsoft Internet Explorer -> Alt+AccessKey+Enter
For Mozilla Firefox -> Alt+Shift+AccessKey

For Google Chrome -> Alt+AccessKey

For Apple Safari -> Alt+Control+AccessKey (Tri-71056)

Object Migration When upgrading the application or importing any large Object Migration package,
the system should not be in Production mode. Also, the System Cache Processing
Mode should be set to Data Load Mode. The System Cache Processing setting can
be found in the TRIRIGA Administration Console's Cache Manager page. After the
import is complete, the system cache can be reset and the system placed back
into Production mode.

Oracle If you are installing a new Oracle database and wish to support multi-byte
characters, make sure your instance character set is UTF-8 or UTF-16 and your
NLS_LENGTH_SEMANTICS is set to CHAR, not BYTE. Follow the instructions in
the IBM TRIRIGA Application Platform 3 Information Center in Installing IBM
TRIRIGA Application Platform to ensure your platform supports multi-byte
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characters properly. (Tri-32998)

If you are upgrading an Oracle database and are considering changing the
instance character set to UTF-8 or UTF-16 to support multi-byte characters, it is
imperative that you carefully follow the instructions in the IBM TRIRIGA
Application Platform 3 Information Center in Installing IBM TRIRIGA Application
Platform. Failure to do so could compromise your data.

Report Manager Reports with blank titles show up first in the list if the database is Microsoft SQL
Server and show up last in the list if the database is Oracle.

Security You can find instructions for managing issues with applets such as the Gantt in
which the applet console reports a security exception under CVE-2010-3560 at
http://www.oracle.com/technetwork/java/javase/6u22releasenotes-

176121 .html.

Security is not applied when a PDF generated from an external report type (BIRT
and Crystal) is emailed. (Tri-88536)

Software Licenses Starting with IBM TRIRIGA Application Platform 3.2, IBM TRIRIGA distributes
software licenses in a separate license file for each product. The license file
names are in the format
LICENSE_IBM_TRIRIGA_{productname}.properties (for example,
LICENSE_IBM_TRIRIGA Application_Platform.properties).

You may continue to use your existing TRIRIGALICENSE . properties file if
you have one. You do not need to replace your TRIRIGALICENSE . properties
file until it expires or your software requirements change.

At the end of an install, your config\licenses directory should contain either
your LICENSE_IBM_TRIRIGA_{productname}.properties files or your
TRIRIGALICENSE. properties file, but not both.

After you start using the
LICENSE_IBM_TRIRIGA {productname}.properties files, do not revert to
the TRIRIGALICENSE. properties file. (Tri-33449)

Attention - All application servers accessing a database must have
X the same license set. The only exception is the license for IBM

TRIRIGA Connector for Business Applications since it may be
licensed only on a limited number of servers and should only be
placed on that number of servers to stay in compliance.

Syclo Syclo has been removed from the IBM TRIRIGA Application Platform
Compatibility Matrix. Customers should contact the vendor with any issues or
concerns regarding Syclo and the IBM TRIRIGA Application Platform.

WebSphere The automated installation of TRIRIGA with WebSphere may fail if the
com. ibm.SOAP. requestTimeout parameter value is not increased. The
parameter can be found in the soap.client.props file within the Application
Server properties directory of WebSphere. Setting this value to O makes it
unlimited.

When using WebSphere, an additional MIME Type is required for certain pages in
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the application to display properly. You must add a new extension, phtml, as
text/html. For more information, go to the IBM TRIRIGA Application Platform 3
Information Center and select Installing IBM TRIRIGA Application Platform.
(Tri-29060)

Use the correct JDK for your WebSphere installation.

If you have two WebSphere installations, one at
/[pathToWebsphere]/IBM/WebSphere/AppServer for WebSphere 8.0

and one at

/[pathToWebsphere]/IBM/WebSphere/AppServer85 for WebSphere 8.5,

using java in the 8.0 installation causes the installation to fail. (Tri-89328)

Known Limitations

The following items are known limitations concerning the IBM TRIRIGA Application Platform for this release:

Area of Impact

Accessibility

Agents

Document
Management

Extract, Transform,
and Load (ETL)

Description
Internet Explorer is the supported browser for accessibility.

In Internet Explorer, section action links do not retain focus after a link’s action
page is opened and closed. (Tri-93030)

On the Personalize page, only the Save and Cancel buttons are accessible. If a
user tabs past the Save and Cancel buttons, the only way to close the Personalize
page is to press Shift+Tab to return to the Save and Cancel buttons. (Tri-93069)

The focus may be lost when users add, rename, delete, or move a bookmark or
bookmark folder.

With keyboard navigation, users can press Shift+Tab until they get to the actions
at the bottom of the bookmark window. For JAWS users, a landmark region can
be used if the focus goes out of the bookmark window. (Tri-92461)

The Incoming Mail Agent is unable to monitor and process incoming mail when
using Microsoft Office 365 Exchange Online.

Double-byte characters do not display when you preview Unicode or UTF-8 .txt
files. You must download the file to see the content. (Tri-36352)

The as-shipped ETL scripts are written against the standard IBM TRIRIGA
database and its database columns, but after an upgrade, a small number of your
implementation’s database column names that were auto-generated during the
upgrade may be slightly different and not match the names in the released ETL
scripts. Review your ETL scripts and change them as needed to ensure the
column names match the generated column names in your database. (Tri-27625,
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Tri-27705)

If you use any of the IBM TRIRIGA Workplace Performance Management products,
any of the IBM TRIRIGA Real Estate Environmental Sustainability products, the
OSCRE features, or ETL Job Items, the name of your IBM TRIRIGA installation
directory and the location of the application server cannot contain spaces. These
applications use Pentaho to run ETLs. Pentaho is a third-party application that
has a startup issue when the name of the directory where the application resides
has a space in it. For more information, see the Pentaho issue database for PDI
2689 at http://jira.pentaho.com/browse/PDI-2689.

Gantt Gantt will not calculate dates after 2037 due to a 3rd-party library limitation
with Netronic. (Tri-129919-1V59123)

Gantt When you use the Gantt with SSO, you must respond to some login prompts to
use the Gantt chart. When you open Gantt in a new window, you must respond to
login prompts as the local Java Web Start downloads the resources from the SSO
protected server, and to another login prompt as the Gantt application connects
to the SSO protected server.

GIS The as-delivered sample editor widget and overview widget sometimes do not
display when the user clears the browser cache and opens the map. Refresh the
map and the widgets show properly. (Tri-81522)

Globalization An issue causing a warning in the LabelManager.log during a label language pack
import of System_triApplicationVersion.xliff does not impact the labels in your
import and will be resolved in the next release. The warning includes the
following text: "Skipping language data import for
[GroupInfo[id=15006695,resname=10.3.2]] because the target record no longer
exists." (Tri-126541)

Globalization Formulas involving a localized field may only calculate the language values (L_
table) of the current user in session. For example, a localized text field is used in
a formula to concatenate with another field value. The calculation of the
language value of the localized text field is based on the language of the current
user in session. The other language values available for the localized text field,
if any, are not included in the calculation of the formula. For example, an Italian
user triggers a calculation of this concatenation formula. The Italian language
value is concatenated and the Italian user can see that the calculated value has
the concatenated Italian language value. However, other users only see the
default internal values (T__ table) calculated in the formula even if there are, for
instance, German or Chinese language values available for the localized text
field.

Similarly, formulas that are processed by the extended formula queue do not use
the language values in the calculation. The extended formula process only uses
the internal values of the localized field in the calculation.

Globalization The following areas are not fully globalized and translated:
Application builder pages are only available in US English, including Form
Builder, Data Modeler, Workflow Builder, and Label Manager. Application builder

pages may show mixed translations if the user’s preference is set to a language
other than US English and the language packs are applied.
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The installer is only available in US English. Installing to a path under Program
Fi les may not work on a non-US English-language version of Windows.

Some pages to which only an administrative user has access are only available in
US English. This includes Application Setup pages, the Administrator Console,
data utilities, and the System, Associations, and Work Flow Instance tabs.

Brava! Viewer labels are available in US English only.
Document paths in BIRT reports are available in US English only.

Globalization You will find information about your label export from the Language Manager in
the LabelManager.log file. Information about your data export from the Language
Manager is in the TranslationData.log file. Only the TranslationData.log is
mentioned in the user message in the Language Manager. (Tri-130875)

Graphics In a Graphics section, the labels for Export and Layer Manager do not render in
Internet Explorer 9 for bidirectional languages. (Tri-133280)

IBM TRIRIGA SVG The IBM TRIRIGA SVG Viewer is not well suited for design-time work and not
Viewer supported for working on very large workflows. Use the Adobe SVG Viewer Plug-
In for design-time work. (Tri-20731)

Language Packs When you import a language pack for the first time, you may see exception
messages in the LabelIManager . 1og file. To eliminate the exception messages,
repeat the import of the language pack.

You may see persistence errors in the Translation. log file when a language
pack is imported into an environment that is upgraded to 3.3 or later with the
10.3 or later object migration package applied. These errors are displayed
because the field that is referenced has been removed from the application. You
do not need to repeat the import of the language pack to correct this issue.

Microsoft Exchange Microsoft Exchange (SMTP) does not support yearly recurrences when day,
weekday, and weekend day are specified for the weekly option. (Tri-39663)

Multi-byte Resource When a resource name contains multi-byte characters, the file format of the
Names powershell file is not in UTF-8 and does not run in the Exchange Management
Shell. Instead, you see a parser error.
The following describes how to convert the powershell to UTF-8.

1) Open the file in a text editor.

2) Go to File > Save As. On the bottom of the save dialog, make sure that the
encoding is set to UTF-8. Save, overwriting the original powershell file.

3) Run the powershell script again. It shows the multi-byte characters as
qguestion marks in the shell, but the multi-byte characters show properly in the
console.

Object Migration Importing records with many associations might take a long time to import.
(Tri-144723)
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Offline Microsoft Exchange converts a sent Microsoft Outlook message (.msg file) and any
attached messages (.msg files) into Multipurpose Internet Mail Extensions (MIME)
format. However, the IBM TRIRIGA Incoming Mail Agent is not designed to
recognize attachments in MIME format. Instead of attaching Microsoft Outlook
.msg messages to another .msg message, you have two options. To attach the
file, either (1) From Microsoft Outlook, save the .msg attachment as a Microsoft
Outlook file template (.oft file). Then, attach the .oft file to the main .msg
message that you are delivering in Microsoft Outlook, or (2) From Microsoft
Outlook Web App (OWA), attach the .msg file to the main email that you are
delivering, in the OWA. After attaching the file, send the message or email.
(Tri-67117)

Reporting Data changes cannot be made via editable query fields if the editable query
contains Group By clauses and if the query is either Query or Report report type.
(Tri-123757-1V55557)

Reporting In metric tabular queries, the Business Object field's source UOM currency
symbol is not taken into consideration, and instead the field's default UOM
currency symbol will display. Metric chart queries do not display currency
symbols. (Tri-38270)

Single Sign-On When you use SiteMinder as a single sign-on solution, you must configure the
BadUrlChars to only "/*,*.,~". The default strings restrict too many URLSs to the
application, causing issues such as not loading the calendar picker. (Tri-133748)

IBM TRIRIGA Application Platform 3.4.1 Changes

The following changes to the IBM TRIRIGA Application Platform are in this release:

Area of Change Description

Administrator Console  Resolved an issue where a user with read-only access did not see the Platform
Maintenance Scheduler managed object and the Scheduler Manager managed
object. (Tri-144149)

Brava Brava 7.2 viewer now works in Internet Explorer 11 browser with compatibility
mode turned on. (Tri-140905)

CAD Resolved issues with the TRIRIGA CAD Integrator/Publisher Application Definition
Integrator/Publisher cache not working correctly. (Tri-136280)

Document Added the triSystemIDSY field to the DM_History business object. The published
Management name now refers to the new field, and the records now refer to the new

published name. (Tri-143123-1V63233)

Gantt Dependency now considers the Working Hours Per Day value in decimals.
(Tri-143121-1v62881)

Gantt Importing from Microsoft Project no longer calculates actual end date if percent
complete is less than 100. (Tri-143101-1V61367)
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Gantt Resolved an issue within Gantt sections where a task could lose its dependencies
to tasks when the task is minimized and the Gantt applet is saved.
(Tri-140716-1V62519)

GIS Resolved an EsriJS issue where non-Admin users were not able to access widgets
on the GIS Map, regardless of whether the "Add Security" check box for a
particular widget was selected. (Tri-144718-1V63741)

Globalization Resolved a currency formatting issue for a non-US English-language user who
enters values in a currency field in a different format than the user's locale.
(Tri-140169)

Graphics Resolved an issue where if an unattached block shares the same layer as an
attached layer (for example triGrossArealLayer in the default application
definition), the graphic loading now loads correctly. (Tri-143114-1V62287)

Graphics Small drawings, such as drawings scaled in meters, now correctly render line
widths. The line width minimum was required to render lines in certain small
drawings that were extremely far from the origin. Now the system detects this
case, logs a warning about it (since moving the drawing closer to the original and
republishing fixes this), and only applies a minimum line thickness for this corner
case. The minimum thickness workaround works for Internet Explorer and
Chrome but does not work reliably in Firefox. (Tri-143118-1V61446)

Licensing A legacy IBM TRIRIGA Facility Management Enterprise license was added back
into the license table. (Tri-143104-1V62946)

Licensing Updated the license table for IBM TRIRIGA Workplace Performance Management
licenses. (Tri-144458)

OSCRE Corrected an issue where an OSCRE XML Import failed with the error "No field
named ‘triJobltemTypeLl' exists". (Tri-142821)

Performance Re-factored some internal SQL calls for Oracle to improve efficiency.
(Tri-143116-1V62170)

Reporting Resolved a Crystal 2011 issue in which Crystal Report PDF attachments on
Workflow Notification emails were corrupt if the report attached to the
Workflow Notification was Crystal Query Report. (Tri-144614)

Reporting Resolved a Metric Chart issue where errors occurred when the primary Group By
value was null. (Tri-143119-1V62245)

Reporting Resolved an issue where the export of query results did not export all of the
data. (Tri-143106-1V61539)

Reporting The "Export" link now shows only when a report is tabular. (Tri-143120-1V62314)

Reporting The "shared groups" column in My Reports now shows for all rows that have a
group specified within its security access. An error was fixed where removing
group security access from at most the second to last row would remove the view
of shared groups from all rows below it. (Tri-145817-1V63756)
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Security Resolved an issue where even though a security group had full access to the
Report Manager, users in that security group were not able to create query
actions.

(Tri-143105-1V62532)

Security Resolved an issue where the "Special View" link was not displayed for users that
were not in the Admin group. (Tri-143109-1V63061)

WebLogic Resolved a WebLogic TRIRIGA Installation issue where Axis.jar was showing up as
a file to add to the classpath in setDomainEnv.sh and setDomainEnv.cmd. Also
resolved an issue where a JSTL library reference in weblogic.xml was
unnecessarily causing WebLogic administrators to manually deploy a WebLogic
JSTL library. (Tri-142511-1V62882)

Workplace An issue has been resolved where the Reserve Outlook Add-in would give the user
Reservation Manager connection errors when there was no network connectivity. (Tri-143110-1V62880)

Workplace Resolved an issue where the "sent by" information of a reservation was not
Reservation Manager processed in the reservation agent. (Tri-143108-1V63051)

Workplace The Outlook Add-in is now properly signed. Users no longer see an unverified
Reservation Manager publisher message. (Tri-126727)

Workplace When the Reserve Outlook Add-in encounters a communication error with

Reservation Manager TRIRIGA, it now displays the credentials pop-up in which you can review and
possibly change your current Add-in connection properties without having to
navigate into the Add-in settings. (Tri-143102-IV63215)

IBM TRIRIGA Application Platform 3.4.1 Properties Files

The following changes to the TRIRIGAWEB. properties file are in this release. For more information, go
to the IBM TRIRIGA Application Platform 3 Knowledge Center and select Installing IBM TRIRIGA Application
Platform > Configuring the platform > Properties files.

Area of Change Description

OSLC_MYPROFILE_RES  The default value of the property OSLC_MYPROFILE_RESOURCE in the
OURCE TRIRIGAWEB.properties file is now triMyProfileRS. (Tri-134474)

SHOW_ZEROS_IN_NUM  The new SHOW_ZEROS_IN_NUMBER_FIELDS property in TRIRIGAWEB.properties is
BER_FIELDS used at record runtime to determine whether number fields render 0 for null
value or show empty field.

When the value is Y, a number field renders zero in a form when the value in the
database is null.

When the value is N, a number field renders empty in a form when the value in
the database is null.

The default value of this property is Y. (Tri-140284)
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TRIRIGAMIDDLEWARE The value for TRIRIGAMIDDLEWARE DATABASE_TYPE can now be db2.
DATABASE_TYPE

© Copyright IBM Corporation 2014. 39



IBM TRIRIGA Application Platform 3.4.0 Enhancements

The following enhancements to the IBM TRIRIGA Application Platform are in this release:

Area of Impact

Description

Admin Console

Application Server

Document Manager

Getting Started

GIS

Globalization

Graphics

The hierarchy tree cache can be configured to include additional hierarchies in
the TRIRIGAWEB. properties. (Tri-132226)

Linux and Unix application servers no longer require X-windows to run the IBM
TRIRIGA Application Platform.

An HTML5 upload feature is included in this release for Document Manager to
remove the Applet dependency.

The getting started information is updated with default user roles, typical user
role tasks, home page, group details, and license details.

An upgrade to the 3.4 platform will switch any As Delivered GIS portal sections
and tabs from using the old ArcGIS classloader technology to using the new EsriJS
classloader technology. It will also import and use the As Delivered EsriJS maps
which are configured similar to the ArcGIS As Delivered configuration, and
update the geocode actions (e.g. Buildings) to use EsriJS. (Tri-125321)

Arabic and Hebrew now have support and mirroring capabilities as bidirectional
languages.

In Label Manager import, you now can choose whether or not to update existing
labels. (Tri-93062)

Label export was moved to the Language Manager in the Administrator Console
from the Label Manager in the application. You can now choose whether to
remove blank tooltips by running a label export for GUI Tooltips or All.
(Tri-101829)

Query results now display internal_value data when translated data does not
exist. Previously, blank values displayed. (Tri-115530)

You now use the Language Manager in the Administrator Console to export
changes to labels. A best practice is to clear Object Metadata Cache in the
Cache Manager of the Administrator Console before exporting labels or data.

When you choose to do a delta export and compare the values with the US
English language pack from installer, the comparison is made with the first file in
the userfiles/LanguagePacks folder. (Tri-92978 and Tri-124098)

Added a new Auto Zoom feature that allows a graphics view to automatically
zoom in to a target record after the graphic loads. Three properties have been
added to the graphics section of forms to control how the zoom behaves:

Auto Zoom - When checked, and there is exactly one associated record in the
graphics section (for example, the space graphic), the view zooms to that record
when the graphic is first rendered. (Tri-119060)

Zoom % - Defaults to 100 percent, but can be used to change the scale factor of
the zoom. For example, 50% is twice as far, and 200% is twice as close. The
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Area of Impact Description

value must be 1 - 400. (Tri-119060)

Zoom Delay - Specifies the amount of time in seconds to wait before Auto Zoom
happens. This allows you to configure the time to see the full context of the
graphic before the zoom occurs. This must be between 0 and 99. Note that the
Zoom Delay will recognize how long a graphic has taken to load and count that
time as part of the delay. For example, if Zoom Delay = 3 and graphic takes 10
seconds to load, the Auto Zoom will happen immediately after load completes.
(Tri-123872)

Email notifications can now be configured to send a single email to all recipients
by adding a boolean field named triSendSingleEmailBL to the mail notification
object. If this boolean is set to 'TRUE' when the notification is sent, it will
include all recipients in a single email to allow the user to use a 'Reply To All
functionality. (Tri-121918-1V55127)

Notifications

OSLC Enablement This release includes an Open Source for Lifecycle Collaboration (OSLC)-
compliant implementation that will be used for future mobile releases.

Portal The row limits on the Notifications and Action Items portal sections are increased
from 50 to 500. (Tri-128520-1V59864)

Text wrapping for editable queries provides better wrapping and usability for
QUL text fields.

Opening records in the Master Detail navigation target has changed. The records
can be viewed either in a popup window or inline in the current window.
Previously this property would default to inline. A change has been made to
make this default configurable in TRIRIGAWEB.properties and the default value
for MASTER_DETAIL_RECORD_VIEW_TYPE is Popup. (Tri-133256)

Reserve query performance includes the following improvements:

Curtailed search - A field can be added to a Reserve Query that allows you to
configure the number of records to be returned from a greater result set.

Reserve thread modeling - This release added new capabilities to enable a total
Reserve Query Thread Pool and another property to specify how many threads
each reserve query request can use. This feature is scalable with hardware and
can be tuned to meet specific use cases and scenarios. (Tri-120227)

Real Estate The platform includes the following enhancements related to TRIRIGA Real
Environmental Estate Environmental Sustainability Impact Manager:

Sustainability
Integration with IBM Tivoli Directory Integrator
Improved metric reports

Generic staging tables were created as a new type of staging table

Reporting BIRT libraries are updated in this release to support the latest version of BIRT.

Upgrade This release includes the following improvements to Object Migration (OM) and
platform builders to ease application upgrades:

Date-based OM package creation
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Improved updated_date management on all OM supported metadata types
Accurate updated_date searches for all OM supported metadata types
Associated data migration

Ability to export and import associated record data by using OM

Support for migration of association metadata

Workflow export text format

Ability to export a workflow to a formatted text file that includes all task types,
task properties, flow control structures, and conditions

Export available for all versions of a workflow

Workflow export available from OM packages in addition to Workflow Builder

IBM TRIRIGA Application Platform 3.4.0 Changes

The following changes to the IBM TRIRIGA Application Platform are in this release:

Area of Change Description

Administrator Console  Added an index on wf_event_history to improve performance on lookups of
completed events. (Tri-132315-1V59981)

Administrator Console  In the Workflow Agent Manager, the per user workflow count can now be
updated dynamically. The dynamically updating thread configuration can be
changed, and the number of total threads on the server can be updated.
(Tri-114875)

Administrator Console  Resolved an issue with the Workflow Events tab in the Admin Console in Firefox.
(Tri-111749)

Application Server Resolved an issue where a large number of events in the queue caused an error
with an SQL statement. (Tri-125572-1V56228)

Application Server The HTTP header Cache-Control can now be configured in the
TRIRIGAWEB.properties file. By default, there is no property in the file; however,
you can override the default values of 15 minutes (900 seconds) for non-
production mode, or 1 week (604800 seconds) for production mode, by adding
CACHE_CONTROL_SECONDS=XXXX where XXXX is a value greater than 900.
(Tri-132531)

Application Server The unused TRIRIGACONVERSION properties file has been removed from the
config directory. (Tri-110499)

Application Server The X Window System is no longer necessary to provide graphical services to the
IBM TRIRIGA Application Platform. (Tri-115136)
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Connector for Business = Text values that are entered for the saveRecord operation are now localized for

Applications non-US English-language users. (Tri-90830)

Connector for Business You no longer can request the Connector for Business Applications wsdl and send
Applications a SOAP request in the same HTTP request without authenticating. (Tri-133622)
Data Modeler Details of financial tokens can now be viewed even when the business object is

published. (Tri-123483)

Database The Oracle driver has been updated to the latest to resolve some issues with
connectivity to 11r2.

Please see the following URL for a list of corrections to the driver:

http://download.oracle.com/otn/utilities_drivers/jdbc/121010/JDBC-
Readme.txt?AuthParam=1378853111 daObd109a8cc47b9ab0a7423515977b7

(Tri-105914)

Document Manager Resolved an issue in Document Manager that caused a unique constraint error if
you double-clicked the Check-In action. (Tri-113176-1V51696)

Document Manager Uploading a document into the Related Documents section on the Notes &
Documents tab is now possible if the project name includes a single quote.
(Tri-120424-1v55020)

Form Builder Resolved an issue where Form Builder was not able to switch to a different tab in
a multi-tab section. (Tri-118832)

Formula Engine A new expression function, replaceCRLF, can be used to replace existing CRLF
(carriage return, line feed, or line break) characters with another tag. For
example, to replace a non-functioning line break with the <br/> syntax, which is
used by the text editor in 10.4, use the following new expression:

replaceCRLF(A, "<br/>")

Where A is the variable to specify where the input string comes from.
(Tri-117359-1V53545)

Gantt Resolved an issue that caused only the top of the last task that was listed in a
Gantt chart to display. (Tri-90820)

Gantt Resolved an issue where tasks from the selected project were not rendering in
the Projects Gantt section. (Tri-113581)

Gantt Resolved an issue with launching the Gantt scheduler applet when running with
an Apache and LDAP SSO configured environment. The login prompt will no
longer be shown for the inline schedule applet. Launching for the first time will
bring up a login prompt through the Java Web Start system, as it connects to
retrieve the code from the server. (Tri-111293-1V52377)
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Gantt The FRONT_END_SERVER no longer needs to be set for Gantt, as Gantt Web Start
was replaced by opening the traditional Gantt Applet in a new window.
(Tri-129103)

Gantt The Gantt Schedule section in a new window is refactored to use a standard
browser window and to remove the web start download/popup. This resolves an
issue where the section would fail because of XSS protections.

(Tri-122320)

GIS An upgrade to the 3.4 platform switches any As Delivered GIS portal sections and
tabs from using the old ArcGIS classloader technology to using the new EsriJS
classloader technology. It also imports and uses the As Delivered EsriJS maps
which are configured similar to the ArcGIS As Delivered configuration, and
update the geocode actions (e.g. Buildings) to use EsriJS. (Tri-125321)

GIS GIS now displays the translated report title that is defined in the GIS query
object in the query list. Previously it displayed the GIS query object name,
which was not translatable. (Tri-122702)

GIS GIS will now translate report headers in the "Show Table" view and "View Record"
when selecting a pin on the map. (Tri-122813)

GIS Removed the extents from the default gray basemap to improve its appearance
when the user switches back to it from another basemap. (Tri-130295)

GIS Resolved an EsriJS editor widget issue that caused a drawing offset when either
the Details tab, or the Table tab, or both, were open. You no longer must close
the tabs before editing. (Tri-116252)

GIS Resolved an EsriJS issue where locator pins were not displaying for non-US
English-language users when the latitude and longitude coordinates were comma
delimited. (Tri-122816)

GIS Resolved an issue where the new ErsiJS was not honoring the $$RECORDID$$ or
$SPARENTRECORDID$$ filters in run reports as ArcGIS did. (Tri-113795-1V53755)

GIS Resolved issues with loading labels from the language pack which happens on
environments using SSO and/or SSL (HTTPS). This is corrected by implementing
and using a direct API instead of relying on a self-post for resources. (Tri-114381)

GIS The geocode search no longer zooms too much into locations, which caused the
map display to be blurry. (Tri-114497)

GIS Two new fields, "Proxy Host" and "Proxy Port", are added to the Integration
Object form that can be used to configure a proxy when using the HttpPost
function. If the Proxy Host is blank, it will not be used. (Tri-109576-1V53465)

Globalization Autocomplete now shows localized values in the drop-down lists. (Tri-129130)
Globalization L_ tables are now deleted when the business object is deleted. (Tri-132814)
Globalization Language values can now be mapped to localized smart section fields of

embedded records. (Tri-131963)
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Globalization Localized values from the updated smart section row are now calculated
properly in the parent record formulas. Formulas involving list field values now
calculate the label translation of the field into the localized calculated value of
the formula if the target field or formula field is localized. (Tri-112821)

Globalization Locator fields can now be localized when the source is a localized system read-
only record name. (Tri-89545)

Globalization Mapping a Classification field to a text field is now fully localizable (short and
full path). (Tri-103771)

Globalization Record name values that include a List, System BO Label, System Form Label, or
Classification field (given the record name of the root classification is localized)
can now be exported for translation and show translation in the form.
(Tri-113883)

Globalization Resolved an issue that caused localized values to not be displayed for Summary
reports. (Tri-122467)

Globalization Resolved an issue with currency formatting when the default language is set to
anything other than US English. (Tri-116260-1V53470)

Globalization The Subject column of the Notifications portal section now renders translated
values. (Tri-125499)

Globalization The translation of a static string is now mapped in the workflow even if the
workflow template id is not the same as the one in the as-delivered language
pack. This occurs when the workflow was created in the environment through an
object migration import rather than from clean installation. In order for this
mapping to work, you must either import the label language pack again or import
only the WFSTATICMAPPINGLABEL.xIiff file again. (Tri-127286)

Globalization Tooltips can now be translated for the Report Manager. (Tri-87558)
Globalization When the display of the full tab list cannot fit on the page, the tab list is
partially rendered. To scroll the tabs, click either the upper or lower empty

cells. (Tri-129389)

Globalization When you run an Excel export, system read-only fields (of GUILABEL subtype) are
now translated. (Tri-119934)

Globalization You can now add a space before a colon in a language pack for linguistic reasons
so that your users can see a space before a colon at run time. For example, if
French users are to see a space before a colon. (Tri-111938)

Globalization You now export labels from the Language Manager in the Administrator Console
instead of from the Label Manager. (Tri-127032)
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Graphics A graphics section was overriding all of the layers in a block to the inserted
layer, which is inconsistent with AutoCAD and MicroStation. Updated the dxf
processing to preserve all of the entity’s original layers. The user can turn
individual block entities on or off by layer, similar to how AutoCAD and
MicroStation work. Also resolved an issue with layer filters by count, which
appeared to not work correctly because all entities within a block were counted
as one entity for the block. (Tri-115013)

Graphics The Label Styles in the Graphic Section are updated to handle bad data in
association label elements more robustly. (Tri-118836-1V57432)

Graphics The Zoom window button now functions in IE 10 and Windows 8. (Tri-113165)

Help An issue has been resolved where the FULL_HELP_OBJECT=N caused just the note
data in the help records not to be displayed. (Tri-134286-1V60607)

Installation Due to a locator field localization dependency between the triCiHierarchyNode
and triCiMapping business objects, a SQL Persistence Error may be written to
server.log during the automatic import of the CIAppManagerMetaUpgrade
upgrade package. This happens the first time an application server is brought up
with IBM TRIRIGA Application Platform 3.4. This log message is normal for the
ClAppManagerMetaUpgrade upgrade package, and the issue is resolved
automatically. The triCiHierarchyNode and triCiMapping business objects are
published correctly. (Tri-133406)

Installation It is now possible to do a platform upgrade from JBoss 5.1.0 GA (Community) to
WebSphere directly by choosing the old TRIRIGA directory in the installer.
(Tri-124086)

Installation WebSphere now updates the JDBC driver class, pointing to the new TRIRIGA
Install directory. WebSphere now installs into a secondary WebSphere profile.
When the WebSphere connection fails, the installer no longer allows you to
continue installation. The installation can continue when the WebSphere
information is correct. (Tri-12322)

Installation When the installer attempts to connect to determine whether WebSphere is
running, the full command is shown if the connection fails. The command can be
copied and pasted into a command line to help troubleshoot the reason for the
failure to connect. (Tri-125924)

Integration Object Resolved an Integration Object file data import issue where the following error
would occur if the file contained a mixture of new and existing data: "A valid
record id must be specified when using a blank value for actionName".
(Tri-124231-1v55986)

Integration Object Resolved an Integration Object HTTP Post issue, where if the request method
type was PUT, null request errors occurred. (Tri-133213)

Integration Object Resolved an Integration Object issue where, if the user triggering the Integration
Workflow does not have the appropriate access, under certain circumstances an
inaccurate error would be displayed in the log indicating "...The context you are
attempting to finalize is not the current context...". Now it displays a no access
error instead. (Tri-114251-1V51854)
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Integration Object Resolved an issue where Integration Object error instance records that were
generated for failures were displaying the same resubmit data rather than data
related to the actual record that failed. The issue made it difficult to resubmit
failed requests. (Tri-116191-1V52941)

Integration Object Reversible encrypted passwords that are used in the IBM TRIRIGA Connector for
Business Applications now unencrypt for the applications to work correctly.
(Tri-103817)

License Updated the license table to give WPME access to run the ETLs through the Job
Scheduler. (Tri-117465)

License and Security Resolved an issue where ETL job items ran without the required license installed.
(Tri-119565)

Localization An onChange workflow in a field that concatenates a localized locator field with
a localized text field to display in a non-localized field now works appropriately
in a non-US English-language environment. (Tri-115069-1V52581)

Navigation Builder An issue has been resolved in the Navigation Builder. Now a navigation collection
cannot be configured for a collection type where the number of levels is not
valid. (Tri-130524-1V59394)

Navigation Builder Resolved an issue where multiple spaces would appear when typing a space while
filtering columns in the Navigation or Portal builders. (Tri-118830-1V53743)

Notifications Approval Escalation is now working correctly, as based on the duration defined in
the Product Request Template. (Tri-128892-1V57384)

Object Migration In a record data export, if the record data path name exceeds the 255 character
Linux file name limit, the record data XML no longer fails to create in the
package. Packaged record data XML files no longer contain the entire name as
the file name, but instead use a hash value for part of the file name.
(Tri-122301)

Object Migration Newly created budget tokens, lists, hierarchy structures, and styles are now
added to an object migration export package when you use the By Date create
mode. (Tri-122881)

Object Migration On import, duplicate queries are no longer created in the same module in the
target environment when the primary business object for the query changed in
the source environment. (Tri-114596)

Object Migration The Create Package By Date option no longer automatically adds dependencies.
To automatically add first-level dependencies, select the check box. (Tri-125821)

Object Migration The export process no longer exports invalid Group module level security access
when an invalid form ID is found on the source environment. (Tri-128990)

Object Migration The Search Results section and the Find Dependents section now have a Reset
Search action that clears the section. (Tri-126546)
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Performance A performance improvement has been made when activating users. In the
previous version, if multiple workflows executing to activate users, the
workflows would bottleneck at the processUserAccess state transition. This
bottleneck has been removed to improve performance. (Tri-118431-1V53583)

Performance Because of known performance issues when not running in production mode, the
Sign-In screen now prominently displays if a system is not in production mode
and that performance will be negatively impacted. (Tri-131279)

Real Estate Lease The currency formatting for Indian Rupees now groups correctly. (Tri-124392-
IV56245)
Record Runtime An issue has been resolved when printing forms where some tabs that are visible

did not render. (Tri-133079-1V60233)

Record Runtime Availability sections are not available for printing, as is the case with other
special sections types like Availability Legacy and Gantt. (Tri-103988)

Record Runtime Corrected an issue where text area locator field with maximum length set to 0
will not allow user to enter any value and do the auto-search. (Tri-117344-
IV53915)

Record Runtime Query sections in forms now can display a loading indicator when a user action is

taken. (Tri-117208)

Record Runtime Resolved an issue where, in some cases, image fields were rendering with a "-1"
in a query output. (Tri-132246)

Record Runtime There is no longer extra white space on the bottom of the tab in a record view of
a Navigation target. (Tri-81359-1V54141)

Record Runtime Users can now create Capital Project records even when JRE is not installed on
the client. (Tri-87994)

Reporting An issue has been resolved with off-loaded BIRT reports with multi-select
parameter values. (Tri-130313-1V59397)

Reporting Corrected an issue where the Summary Report header name display escaped
characters such as x20. (Tri-126196-1V56543)

Reporting Corrected an issue where using the System Readonly Created DateTime (Number)
field or the System Readonly Modified DateTime (Number) field as static filters in
report would throw a stack trace. (Tri-120226-1V54273)

Reporting Form names are now translated when they appear in query results.
(Tri-112998)

Reporting Number fields in an Excel file that was exported from a TRIRIGA report are now
correctly formatted when the user has a European region and language setting.
(Tri-119231-1v54050)
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Reporting Ordering now works correctly when a field in the Summary Report is part of both
Group By and Order By. (Tri-126518-1V56549)

Reporting Resolved an issue where exported values were not exported with translated
values when users with a default language other than US English exported a
report containing a classification field. (Tri-116869-1V53481)

Reporting Resolved an issue with the display of incorrect results in groupings when
exporting to Excel from reports when the grouping was not configured in the
report. (Tri-122298-1V54944)

Reporting Results now display when a non-US English language user enters key words in the
Excel Template search. (Tri-110333)

Reporting The BIRT report engine version has been upgraded to 4.3.1. (Tri-119284)

Reporting The JSTL 1.2 library is now automatically deployed. This corrects an issue where
metric reports would not run on Weblogic 11. (Tri-117761)

Reporting The Order & Group tab now displays correctly when rendered in the Chrome
browser. (Tri-124219)

Reporting The save action on an editable query with an associated BO now works correctly.
(Tri-117461-1v53544)

Reporting The thousand separator is now displayed in number fields that are exported to
Excel, based on the regional settings set in the operating system.
(Tri-122228)

Security A security issue was resolved in data integrator so that it is no longer possible to
upload a data integrator file with two dots in the name, such as
MyFile..Upload.txt. (Tri-131778)

Security Document Manager now enforces read-only licensing. If your license grants you
read-only access to the Document module, you can no longer make changes in
the Document Manager. (Tri-115605)

Security Resolved an issue when attempting to send an error report to IBM's PMR system
with non alpha-numeric values in the PMR or Customer fields. (Tri-133737)

Security The IBM TRIRIGA Workplace Reservation Manager license now has access to run
ETLs and the job logs. The IBM TRIRIGA Real Estate Environmental Sustainability
Impact Manager license no longer has access to either. (Tri-123746)

Security The Reserve Location Request functionality requires a Self-Service, Facilities, or
Operations license.

The functions for triMaintenance > triJobPlansPMs and triMetricFact >
triStandardHoursDetails are now licensed correctly. (Tri-133517)

Security The “system’ user now has access to all the licensed functionality on the server.
(Tri-115343)
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Security

Security

System Setup

Workflow

Workflow

Workflow

Workflow

Workflow
Workplace
Reservation Manager

Workplace
Reservation Manager

Workplace
Reservation Manager

Workplace
Reservation Manager

Workplace
Reservation Manager

Workplace
Reservation Manager

Two new licenses are now available for IBM TRIRIGA:

- IBM TRIRIGA Workplace Reservation Manager for Small Installations (3044)
- IBM TRIRIGA Workplace Reservation Coordinator (3045)

(Tri-129220)

Updated the license table to remove the invalid settings that gave the WPME
access to some Builders/Managers. (Tri-115346)

Updated the installation and upgrade documentation for Weblogic. (Tri-116421-
IV53472)

Resolved an issue for Schedule tasks where values for a recurrence were not
saved. (Tri-127779)

Resolved an issue in Schedule tasks that caused the End By date for a recurrence
to increment by one day each time the task was opened. (Tri-127781)

Resolved an issue that prevented formula field mapping from being cleared when
the Clear All action was clicked during workflow mapping. (Tri-80268)

Resolved an issue where forms with a multi-tab section that is marked as visible
but has no visible sub tabs would become unresponsive after an onchange
workflow. (Tri-115710)

When a record with a dependent association is created, the System Record ID
now updates properly. (Tri-106501)

Exchange integration now works with Jboss EAP. (Tri-115231)

Resolved an issue that caused a canceled occurrence in Outlook to cancel the
wrong event. (Tri-114055)

Resolved an issue where an internal library within the IBM TRIRIGA Platform
could not find new Time Zone IDs. The library has been updated and contains the
new time zones. (Tri-115990-1V52424)

The IBM TRIRIGA Workplace Reservation Manager Outlook no longer
communicates with IBM TRIRIGA when Outlook is offline. (Tri-128965-1V59312)

The Reserve Outlook add-in now supports Siteminder SSO. (Tri-124583)

The Workplace Reservation Manager Outlook add-in installer can now be run in
silent operation. Create a silent install.properties file with the responses for the
graphical installer's prompts. Run the add-in installer as follows: install.exe -i
silent -f install.properties. Be sure that all prerequisites are met before
installation. (Tri-118073)
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IBM TRIRIGA Application Platform 3.4.0 Properties Files

The following changes to the TRIRIGAWEB . properties file are in this release. For more information, go
to the IBM TRIRIGA Application Platform 3 Knowledge Center and select Installing IBM TRIRIGA Application
Platform > Configuring the platform > Properties files.

Area of Change Description

Brava Brava 5.5j support has been replaced with Brava Enterprise 7.2 Server support.
Please see Developer Works for additional information on how to obtain Brava
7.2 Enterprise and license. (Tri-115581)

Brava Properties in the TRIRIGAWEB.properties file that were related to Brava 5.5j
have been removed. (Tri-129612)

ENFORCE_REQUIRED_V  OSLC ignores the value of the ENFORCE_REQUIRED_VALIDATION property in the

ALIDATION TRIRIGAWEB.properties file. (Tri-106622)

UNSUCCESSFUL_LOGIN = A new property is added to TRIRIGAWEB.properties file named

_ATTEMPT "UNSUCCESSFUL_LOGIN_ATTEMPT". Default value is -1.
#
# This property is to determine how many number of unsuccessful login attempts
are allowed
# before the account gets locked. Default is -1 which means functionality is
turned off.
# Any positive value will mean only that many unsuccessful login attempts are
allowed.

# Once reached that account will be locked and can only be unlocked by a
system administrator

# from the Admin Console -> User Manager page.

#

UNSUCCESSFUL_LOGIN_ATTEMPT=-1

(Tri-119066)
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IBM TRIRIGA CAD Integrator/Publisher 12.1.1

This release includes important information, known limitations, changes, and property file changes to IBM
TRIRIGA CAD Integrator/Publisher.

Important Information

The following items are important information concerning IBM TRIRIGA CAD Integrator/Publisher for this
release:

Area of Impact Description
AutoCAD If you are using AutoCAD 2012 64-bit, you must be on SP1 or later. (Tri-37066)
Hover Help If the hover help you are reading closes before you can finish, move your mouse

away and then back to redisplay the hover help.

IBM TRIRIGA To use IBM TRIRIGA CAD Integrator/Publisher 12.1, you must be on IBM TRIRIGA
Application Platform Application Platform 3.4. To use IBM TRIRIGA CAD Integrator/Publisher 12.1.1,
you must be on IBM TRIRIGA Application Platform 3.4.1.

Single Sign-On If you are using SSO through IIS, you must have the Basic authentication option
selected in order for IBM TRIRIGA CAD Integrator/Publisher to sign in properly.
You can use any other combination of authentication options (Basic, Digest, and
Windows Integrated), provided that both Digest and Windows Integrated are not
selected at the same time. (Tri-21349)

Known Limitations

The following items are known limitations concerning IBM TRIRIGA CAD Integrator/Publisher for this release:

Area of Impact Description

Data IBM TRIRIGA CAD Integrator/Publisher for AutoCAD supports multi-byte
characters in drawings, windows, and records. IBM TRIRIGA CAD
Integrator/Publisher for MicroStation supports multi-byte characters in IBM
TRIRIGA CAD Integrator/Publisher windows and in IBM TRIRIGA records.

Globalization IBM TRIRIGA CAD Integrator/Publisher is only translated to languages to which
AutoCAD is translated.

Installer The installer is only available in US English. By default Install Anywhere installs
to a folder with the literal value Program Filles. On non-US English-language
versions of Microsoft Windows, this folder has a translated name and an install to
a folder named Program Files may not work. If you are installing IBM TRIRIGA
CAD Integrator/Publisher on a non-US English-language version of Windows,
install to a folder with a different name. For example, C:\CI.
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Area of Impact Description

MicroStation For MicroStation users of IBM TRIRIGA CAD Integrator/Publisher, the areapat.cel
file is required in order for fills to work properly. TRIRIGA CAD
Integrator/Publisher expects the areapat.cel file to be in the
C:\ProgramData\Bentley\MicroStation V8i (SELECTseries)\WorkSpace\System\Cell
folder. If you do not have a C:\ProgramData\Bentley\MicroStation V8i
(SELECTseries)\WorkSpace\System\Cell folder installed, you can resolve the
problem by taking the following steps:

1. Create the C:\ProgramData\Bentley\MicroStation V8i
(SELECTseries)\WorkSpace\System\Cell folder.

2. Copy the areapat.cel file in the C:\ProgramData\Bentley\MicroStation
V8i\WorkSpace\System\Cell folder to the C:\ProgramData\Bentley\MicroStation
V8i (SELECTseries)\WorkSpace\System\Cell folder.

As a result, the areapat.cel file is in both of the folders:
C:\ProgramData\Bentley\MicroStation V8i\WorkSpace\System\Cell
C:\ProgramData\Bentley\MicroStation V8i (SELECTseries)\WorkSpace\System\Cell

(Tri-143115)

Publish A graphics section does not render entities output to the DXF paper-space.
(Tri-32950)

IBM TRIRIGA CAD Integrator/Publisher 12.1.1 Changes

The following changes to IBM TRIRIGA CAD Integrator/Publisher are in this release:

Area of Change Description

Detach Object MicroStation now removes blocks that were inserted originally when
detaching them. (Tri-143107-1V62526)

Drawings Resolved an issue that caused an error when opening a version 10 upgraded
drawing in version 12.1.x. (Tri-145538)

Reporting Resolved an issue where applying hatches did not work correctly when
there were any open attached polylines or complex regions, i.e., more
than one boundary loop or includes "holes" involved. Updated to support
hatching complex regions, which, due to limitations in AutoCAD, includes
full support for normal polylines and circles, but only partial support for
complex regions with arcs or ellipses. TRIRIGA CAD Integrator/Publisher
does not support hatching open polylines, but the presence of these
entities no longer causes normal boundaries to fail to hatch.
(Tri-143117-1V61530)

Smart Attach Resolved an issue where a MicroStation drawing with large Element IDs (for
example, greater than 4,000,000,000) failed to attach gross, attach
measured gross, attach object, or upload areas. (Tri-143111-1V63152)
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Smart Attach

Upgrade

Resolved an issue in which running the Smart Attach or Batch Process on a
drawing with a large number of spaces did not link all of the spaces on the

first upload. (Tri-136599)

TRIRIGA now updates the attachment state for legacy TRIRIGA CAD

Integrator/Publisher version 10 drawings that have been upgraded. These
drawings now appear with the correct state in the "Open Drawing from
Record" and the various attachment dialogs.

TRIRIGA CAD Integrator/Publisher now upgrades the Measured Gross area
correctly on version 10 drawings. Also the drawing upgrade process now
automatically runs Sync Full to complete the upgrade. Improved the
messages for upgrade. (Tri-143122-1V63235)

IBM TRIRIGA CAD Integrator/Publisher 12.1.1
Properties Files

The ci .properties file did not change in this release.

IBM TRIRIGA CAD Integrator/Publisher 12.1.0
Enhancements

The following enhancements to IBM TRIRIGA CAD Integrator/Publisher are included in this release:

Area of Impact

Description

Authentication

Certifications

Graphics

Java

Mappings

The authentication type can be basic, preemptive basic, or NTLMv2.

IBM TRIRIGA CAD Integrator/Publisher is now certified for MicroStation V8i Select
Series 3 with Microsoft Windows 8.

Inserted blocks with multiple layers now retain the individual layers in IBM
TRIRIGA Graphics sections.

The IBM TRIRIGA CAD Integrator/Publisher 12.1.0 installation supports Java 7.
Support for Java 6 is deprecated.

Added a field to the Mapping form to specify a detach action to run a specified
state transition when detaching a drawing or object. This includes detaching
from the context menu. If the detach action transition is blank, or is not a valid
transition for the state a record is in, no transition will occur.

Situations that detach children entities along with the parent entity, like detach

drawing (detach all entities) and detaching a space with child items, will call the
detach transition, if applicable, on all children. (Tri-92976)

The display of the full hierarchy path for mappable smart section fields can be
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Area of Impact Description

configured in CAD mappings and enabled in the Smart Attach, Batch Process, and
Batch Edit forms.

In the Space Mapping, Current Use Space Class Mappable Special Field, set the
new Associated Mapping locator to point to the Space Class Mapping. In the
Space Class Mapping, add a "Path" Special field and configure it on the triPathTX
field on the Space Class business object. You can choose any field to represent
the "path"”.

This can be similarly applied to any Smart Section-based mappable special field.
When this is done, the full path is available as tooltips in the list selector. In

addition, there is a check box to allow the user to show the full path. A search
field has also been added. (Tri-114048-1V51850)

IBM TRIRIGA CAD Integrator/Publisher 12.1.0 Changes

The following changes to IBM TRIRIGA CAD Integrator/Publisher are in this release:

Area of Change Description

Attach Gross Area Updated Attach Gross and Attach Measured Gross to display a message
when cancelling out of the command, rather than logging an error.
(Tri-110947)

Batch Edit Added a Show By Path check box to Batch Edit to allow the user to see the
full path of a smart section text field record. This check box will only be
enabled if the field is configured in the application definition by a
mappable special field that is associated mapping and path field.
(Tri-126870)

Detach Detaching a drawing and all drawing data now remove the legend.
(Tri-88286)
Detach Resolved an issue where detaching a space in MicroStation did not unlink

child block elements, such as inserted/attached people or assets, as
AutoCAD does. (Tri-109211)

Detach Resolved an issue where you could not detach an object from the context
menu in MicroStation. Also resolved an issue in both AutoCAD and
MicroStation where using context menu detach object on a boundary
detached child items on the plug-in but did not detach them on the server.
(Tri-109322)

Detach Resolved performance issues when detaching a space in drawings with a
large number of spaces and a large number of attached items. (Tri-125549-
IV56620)

Globalization Resolved an issue where the CAD Integrator/Publisher installer did not set

the correct language settings for Polish. (Tri-130106)

Labels CAD Integrator/Publisher labels now maintain the correct justification
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Area of Change

Login

Menu

Preferences

Publish

Publish

Reporting

Single Sign-On

Smart Attach

Smart Attach

Smart Attach

Description

when the user syncs, publishes, or changes the label style in AutoCAD.
(Tri-114880-1v52348)

CAD Integrator/Publisher works with Siteminder using basic authentication
when you enable "Support non-browser clients" in the Siteminder
configuration. (Tri-125600)

Resolved an issue where the Drawing Properties menu item was incorrectly
set to active for an unattached design file. (Tri-89367)

Server environments no longer save the "/" at the end of URL string so that
functions that open the TRIRIGA application or a record in a browser
window open correctly. (Tri-112358)

In the Graphics section, the polyline to arc transformation now correctly
displays a non-positive unit Z normal. This corrects an issue on certain
MicroStation drawings where doors appeared to be flipped on publish.
(Tri-113522-1v51712)

Resolved an issue that could cause a crash when publishing design files
using MicroStation SS3 on Windows 8. (Tri-115744)

Resolved issues with the alignment of the color in the legend of AutoCAD
when there are multiple results and updated the color graphic to have a
border. (Tri-109773)

CAD Integrator/Publisher log-in now supports NTLMv2 authentication
through 1IS. Fields were added for configuring a proxy host and port for an
environment. The SSO type selector was renamed Authentication, and the
options were renamed to Basic, Preemptive Basic, and NTLMv2. (Tri-67173)

In AutoCAD, the upload candidates now correctly process children of
existing linked spaces as subspaces. (Tri-90230)

Resolved an issue where spaces were not created in CAD
Integrator/Publisher if the parent floor had a reference to a renamed or
deleted organization in the system organization field. Now, CAD
Integrator/Publisher logs an error for a misconfigured sys org field but still
creates a space. Some users do not use the system organization field for
security, and, if they frequently change their organization structure, then
CAD Integrator/Publisher will no longer be affected by this issue.
(Tri-121667-1V56564)

Updated the CAD Integrator/Publisher application metadata to be able to
configure a query to control the results for Space Class Current:

In the Space Mapping, Current Use Space Class Mappable Special Field, set
the new Associated Mapping locator to point to the Space Class Mapping.
Now you can change or update the query on the Space Class Mapping in
order to control the results that show up in the selector in CAD
Integrator/Publisher.

This can be similarly applied to any Smart Section based Mappable Special
Field. (Tri-113848)

© Copyright IBM Corporation 2014. 56



IBM TRIRIGA CAD Integrator/Publisher 12.1.0
Properties Files

The following changes to the ci .properties file are in this release:

Area of Change Description

AUTO_UPGRADE

FLATTEN_Z ON_TEXT_
ENTITIES_WHEN_UPLO
ADING

ACCEPT_UNCLOSED_B
OUNDARIES_WHEN_UP
LOADING

The AUTO_UPGRADE property applies to AutoCAD only. It controls the automatic
upgrade of IBM TRIRIGA CAD Integrator/Publisher (CI) version 10 drawings. When
set to Y, the default, Cl version 12 upgrades any drawing from version 10 when it
is opened. When set to N, version 10 drawings appear as unattached in version
12. You can use the TRGA_UpgradeXData command or set the AUTO_UPGRADE
property to Y to upgrade drawings. If you run TRGA_UpgradeXData, you must
first save the drawing and then reopen the drawing to refresh the Cl menu state.
(Tri-114329)

In AutoCAD, drawing entities are usually represented in three dimensions and the
geometry of the vertices typically has (x,y,z) coordinates. However, CAD
Integrator expects that the floor plans are in only two dimensions, with (x,y)
vertices and z=0.

Two new properties in the ci .properties file control how CAD Integrator
behaves in AutoCAD when you upload floor plans. The

FLATTEN_Z ON_TEXT_ENTITIES_WHEN_UPLOADING property assumes Z=0 for
uploading, which is the default behavior. The
ACCEPT_UNCLOSED_BOUNDARIES_WHEN_UPLOADING property, which defaults
to N, can be set to Y to treat unclosed boundaries as valid for uploading
candidates. When set to N, Cl ignores unclosed boundaries, which was the
behavior in previous Cl releases. (Tri-92362)

© Copyright IBM Corporation 2014. 57



IBM TRIRIGA Supported Versions and IBM
TRIRIGA Application Platform Compatibility
Matrix

The IBM TRIRIGA Supported Versions lists information related to IBM TRIRIGA’s supported products and
platform and relays information about end-of-life plans for such software. The IBM TRIRIGA Application
Platform Compatibility Matrix lists supported operating systems, databases, and related details for and
about the IBM TRIRIGA Application Platform and relays information about end-of-life plans for such software.
The IBM TRIRIGA Supported Versions and the IBM TRIRIGA Application Platform Compatibility Matrix may
change over time. The IBM TRIRIGA Supported Versions and the IBM TRIRIGA Application Platform
Compatibility Matrix can be found on the IBM TRIRIGA wiki at
https://www.ibm.com/developerworks/community/wikis/home?lang=en#/wiki/IBM+TRIRIGA1/page/Support
+Matrix.

Related Documentation

You will find the documentation for this release in the IBM TRIRIGA 10 Knowledge Center at
http://www.ibm.com/support/knowledgecenter/SSFCZ3 10.4.1/com.ibm.tri.doc 10.4.1/product landing.ht
ml and in the IBM TRIRIGA Application Platform 3 Knowledge Center at
http://www.ibm.com/support/knowledgecenter/SSHEB3 3.4.1/com.ibm.tap.doc 3.4.1/product landing.ht
ml. The documentation can be found in online IBM Knowledge Center topics, or in PDF files, or both.

This release introduces the following new documentation.

An IBM TRIRIGA Real Estate Environmental Sustainability Impact Manager toolkit is available on the IBM
Integrated Service Management Library. The toolkit assists customers and service providers in developing
integrations that periodically load energy usage and energy sensor data into IBM TRIRIGA. The data is used
by analytics and for reporting. This toolkit can be found at
http://www.ibm.com/software/ismlibrary?NavCode=1TW10IB09.

The following videos that demonstrate how IBM TRIRIGA self-service users can request services and reserve
company resources for themselves or for others are available:

IBM TRIRIGA Self-Service Users - Requesting Services - Includes information about how to use Request Central
to make online requests for services, repairs, or products and to manage and track each request

IBM TRIRIGA Self-Service Users - Reserving Company Resources - Includes information about how to use
Request Central to reserve resources like meeting rooms, workspaces, food services, vehicles, and
equipment

IBM TRIRIGA Self-Service Users - Reserving Company Resources from Outlook - Includes information about
how to use the IBM TRIRIGA reservation add-in for Outlook® messaging software to create appointments in
Outlook and connect to IBM TRIRIGA to reserve company resources

The videos are located in the Media Library at
https://www.ibm.com/developerworks/community/wikis/home?lang=en#!/wiki/|BM+TRIRIGA1/page/Media+
Library.

The IBM TRIRIGA Inventory Management User Guide is now available as part of the IBM Knowledge Center,
rather than only as PDF. (Tri-109355-1V50672)
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This release updates the following documentation.

“Administering IBM TRIRIGA” (online topics) or IBM TRIRIGA 10 Application Administration User Guide (PDF)

“Assessing and improving the physical condition of facilities” (online topics) or IBM TRIRIGA 10 Facility
Assessment User Guide (PDF)

“Getting started” (online topics) or IBM TRIRIGA 10 Getting Started User Guide (PDF)

“Installing IBM TRIRIGA Application Platform™ (online topics) or IBM TRIRIGA Application Platform 3
Installation and Implementation Guide (PDF)

“Integrating data by using OSLC” (online topics) or IBM TRIRIGA Application Platform 3 OSLC Integration
Guide (PDF)

“Integrating data with the TRIRIGA integration object,” “Integrating data with the TRIRIGA connector for
Esri Geographic Information Systems (GIS),” and “Extending connector functions™ (online topics) or IBM
TRIRIGA Application Platform 3 Connector User Guide (PDF)

“Integrating, publishing, and reporting on CAD drawing information” (online topics) or IBM TRIRIGA CAD
Integrator/Publisher User Guide (PDF)

“Localizing applications” (online topics) or IBM TRIRIGA Application Platform 3 Localization User Guide (PDF)
“Managing graphics” (online topics) or IBM TRIRIGA Application Platform 3 Graphics User Guide (PDF)
“Managing inventory” (online topics) or IBM TRIRIGA 10 Inventory Management User Guide (PDF)

“Managing leased and owned property contracts” (online topics) or IBM TRIRIGA 10 Lease and Owned
Property Contract Management User Guide (PDF)

“Managing portfolio data” (online topics) or IBM TRIRIGA 10 Portfolio Management User Guide (PDF)
“Managing procurement” (online topics) or IBM TRIRIGA 10 Procurement Management User Guide (PDF)

“Managing real estate environmental sustainability” (online topics) or IBM TRIRIGA 10 Real Estate
Environmental Sustainability User Guide (PDF)

“Managing reservations and reservable resources” (online topics) or IBM TRIRIGA 10 Reservation Management
User Guide (PDF)

“Managing services” (online topics) or IBM TRIRIGA 10 Maintenance and Service Management User Guide
(PDF)

“Managing spaces and moves” (online topics) or IBM TRIRIGA 10 Space and Move Management User Guide
(PDF)

“Performance Framework” (online topics) or Application Building for the IBM TRIRIGA Application Platform 3:
Performance Framework (PDF)

“Planning real estate transactions and projects” (online topics) or IBM TRIRIGA 10 Real Estate Transaction
Management User Guide (PDF)

“Strategic facility planning” (online topics) or IBM TRIRIGA 10 Strategic Facility Planning User Guide (PDF)
Application Building for the IBM TRIRIGA Application Platform 3 (PDF)

Application Building for the IBM TRIRIGA Application Platform 3: Calculations (PDF)

Application Building for the IBM TRIRIGA Application Platform 3: Data Management (PDF)

IBM TRIRIGA Application Platform 3 Administrator Console User Guide (PDF)

IBM TRIRIGA Application Platform 3 Connector for SAP BusinessObjects User Guide (PDF)

IBM TRIRIGA Application Platform 3 Object Migration User Guide (PDF)

IBM TRIRIGA Application Platform 3 Reporting User Guide (PDF)

IBM TRIRIGA Application Platform 3 Single Sign-On Setup User Guide (PDF)
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IBM TRIRIGA Application Platform 3 Upgrade Installation Guide (PDF), which can be found at
https://www.ibm.com/developerworks/community/wikis/home?lang=en#/wiki/IBM+TRIRIGA1/page/Upgradi

ng
IBM TRIRIGA Application Platform 3 User Experience User Guide (PDF)

IBM TRIRIGA Connector for Business Applications 3 Technical Specification (PDF)
IBM TRIRIGA 10 Request Central User Guide (PDF)
IBM TRIRIGA 10 Reservation Management User Guide (PDF)

Support

IBM Software Support provides assistance with product defects, answering FAQs, and performing rediscovery.
View the IBM Software Support site at www.ibm.com/support.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult
your local IBM representative for information on the products and services currently available in your area.
Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product, program, or service that
does not infringe any IBM intellectual property right may be used instead. However, it is the user's
responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document.
The furnishing of this document does not grant you any license to these patents. You can send license
inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual
Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan, Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions
are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS 1S" WITHOUT WARRANTY
OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow
disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made
to the information herein; these changes will be incorporated in new editions of the publication. IBM may
make improvements and/or changes in the product(s) and/or the program(s) described in this publication at
any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any
manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the
materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this one)
and (ii) the mutual use of the information which has been exchanged, should contact:
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IBM Corporation
2Z4A/101

11400 Burnet Road
Austin, TX 78758
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any
equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of those products, their published
announcements or other publicly available sources. IBM has not tested those products and cannot confirm
the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on
the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice,
and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them
as completely as possible, the examples include the names of individuals, companies, brands, and products.
All of these names are fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

Privacy Policy Considerations

IBM Software products, including software as service solutions, (“Software Offerings”) may use cookies or
other technologies to collect product usage information, to help improve the end user experience, to tailor
interactions with the end user or for other purposes. In many cases no personally identifiable information is
collected by the Software Offerings. Some of our Software Offerings can help enable you to collect
personally identifiable information. If this Software Offering uses cookies to collect personally identifiable
information, specific information about this offering’s use of cookies is set forth below.

This Software Offering does not use cookies or other technologies to collect personally identifiable
information.

If the configurations deployed for this Software Offering provide you as customer the ability to collect
personally identifiable information from end users via cookies and other technologies, you should seek your
own legal advice about any laws applicable to such data collection, including any requirements for notice
and consent.

For more information about the use of various technologies, including cookies, for these purposes, see IBM’s
Privacy Policy at www.ibm.com/privacy and IBM's Online Privacy Statement at
www.ibm.com/privacy/details in the section entitled “Cookies, Web Beacons and Other Technologies” and
the "IBM Software Products and Software-as-a-Service Privacy Statement" at
www.ibm.com/software/info/product-privacy/.
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Trademarks

IBM, the IBM logo, ibm.com, and TRIRIGA are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of
Adobe Systems Incorporated in the United States, and/or other countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its
affiliates.

Other product and service names might be trademarks of IBM or other companies. A current list of IBM
trademarks is available on the Web at “Copyright and trademark information” at
www.ibm.com/legal/copytrade.shtml
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